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Vision

Welcome to Vision 2021 pre-visualization software for entertainment design and production professionals. 
Vision allows you to previz the conventional lights, moving lights, video, and other effects that make up a 
production, simulated in the context of the event venue. Use Vision to program and cue your show, 
whether you are selling a concept to the client, testing lighting cues, or conforming lighting systems for a 
new venue. You can previz without being at the venue or having a crew on standby. Experiment with looks 
and cues, and review the options with clients and artists before the actual load-in. 

For quick answers while using a feature in Vision, use Context-sensitive help.

New features
The following table contains a list of new and improved features for the initial release of the Vision 2021 
software. 

Click here for a video tip about this topic (internet access required).

Feature Purpose Location
Disguise EVO integration Vision supports integration with Disguise EVO, to 

enable lighting visualization and media 
programming for .mvr files

Rendering video with 
Disguise EVO
DMX control of the 
Disguise camera
Document preferences: 
Rendering tab

New DMX-controlled 
cameras

New cameras are available in the DMX Controls 
dialog box; these allow a lighting console or other 
integrated program to control the viewport view 
with DMX. 
• The pre-existing cameras were renamed as 

Relative cameras. 
• A new Absolute camera uses DMX to set the 

camera position and control the FOV. 
• A new Disguise camera enables integration 

with the Disguise EVO program.

Using DMX controls

Performance 
improvements

The physics and rendering engines have been 
reworked for significant performance 
improvements

Not applicable

Patching improvements In addition to patching fixtures, the Patch dialog 
box now supports the patching of RGB mesh 
objects; DMX transforms; and DMX-controlled 
cameras, ambient intensities, and haze speeds

Patching

Finer control of shadows A new document preference, Cast Shadows, 
controls shadow behavior for individual objects 
and layers

Object and fixture 
parameters

https://www.youtube.com/watch?v=LwOBMaNm-Co&list=PLiLCoe7DU1HbYig_mnACKbjjWkNNCksqZ
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~~~~~~~~~~~~~~~~~~~~~~~~~
Installing and launching Vision
Using Vision with Vectorworks
Vision basics
Customizing the display
Opening files
Merging files
Saving files
The Scene window
Preferences
Editing the scene
The Properties palette
DMX transforms
Assigning textures
Focusing conventional fixtures
Saving the scene as an image
Saving the scene as a movie
Using DMX controls
Patching
Using the help system
Copyright and trademark information

Higher quality metal 
materials

Shiny materials now appear more realistic due to 
the following updates:
• Ambient lighting creates specular highlights.
• Objects reflect the environment when a 

panoramic background or background color is 
applied.

Object and fixture 
parameters

New icons New icons for tools and the DMX Recorder give 
the Vision interface a modern look

Not applicable

Texture transparency 
options

Now you can use the alpha channel from the 
primary texture as the rendering mask, or use an 
alpha texture

Object and fixture 
parameters

Finer control of the bump 
effect on textures

Now you have finer control of Bump Strength, to 
control the intensity of surface contours for all 
textures

Document preferences: 
Rendering tab

Simplified Properties 
palette for a multiple 
selection

For a multiple selection of scene items, the 
Properties palette has been condensed for easier 
navigation. Now it shows only one set of 
parameter values for all selected items. 
Heterogeneous values are clearly indicated by 
two asterisks.

The Properties palette

Better palette navigation Now you can expand or collapse all “child” items 
on the Scene Graph palette and Properties 
palette

The Scene Graph palette
The Properties palette

Feature Purpose Location
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Installing and launching Vision
The Vision installation program lists the installation system requirements, any known installation issues, 
and any information that changed in the software after final online help was produced. To ensure a smooth 
installation, confirm that system requirements are met and take note of any issues or incompatibilities prior 
to installing the software.

The installer includes an option to collect usage data for software improvement. You can select the type 
and amount of data collected, and change this setting at any time from the Vision preferences: Session tab 
in the Vision application.

If you plan to use a video capture source, it must be compatible with UVC (USB Video Class) and use a 
supported pixel format. For more information, see Vision Capture Input Requirements.

The installer uses a serial number to determine whether the license is valid and to allow access to the 
correct number of universes.

If no serial number is entered, a dongle can be used to activate the program. Prior to launching Vision, 
insert the dongle that came with your software into an available USB port. The dongle may need to be 
updated to run the latest version of Vision; see Updating the dongle. At launch, Vision detects and verifies 
the dongle and provides access to the correct number of universes.

Vision launches in demonstration mode when a valid license cannot be found. A sample file opens 
automatically, and a sample DMX file is also loaded to the DMX recorder. Additional sample files are 
available in the Demo Documents folder within the Vision folder. Only these files can be opened in 
demonstration mode, and they cannot be edited. The Vision watermark displays on the Scene window 
viewports. 

When Vision launches with a valid dongle or serial number, either open or create a scene file. If a file was 
sent from Vectorworks using the Send to Vision command, Vision launches automatically and opens the 
file.

Launching in Safe Mode
If Vision quits unexpectedly, you will be prompted to relaunch the program in Safe Mode. This is only 
recommended if a custom setting or inadequate hardware prevents you from opening Vision properly. In 
Safe Mode, all user settings are reset to factory defaults, and any custom settings are lost. To prevent 
crashing, the scene is rendered at low quality; this mode is not suitable for programming a show. “SAFE 
MODE” displays at the top left of the Scene window viewport when Safe Mode is active. To exit Safe Mode, 
close and then relaunch Vision.

Updating Vision
Updating the application

Between major releases, the Vision application is regularly updated by service packs. These are 
maintenance releases that sometimes add new features and functionality, or provide smaller updates to 
address more urgent issues. For information about Vision and service pack updates, see the Community 
Forums.

Command Path
Update Vision Help

https://forum.vectorworks.net/index.php?/articles.html/articles/tech-bulletins/vision-capture-input-requirements-r743/
https://forum.vectorworks.net/index.php?/forum/58-vision/
https://forum.vectorworks.net/index.php?/forum/58-vision/
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To update the Vision application:

1. Select the command.

If an update is available, the Vision Update Control Center opens to guide you through the process.

2. The Update Control Center may require an update. If so, click Update; it will update and launch.

3. The Update Control Center indicates in the text on the left whether an update is available, or your 
version of Vision is up to date. If an update is available, click Update. If Vision is still open, you are 
prompted to close it.

During the update, the necessary files are automatically downloaded and installed. When 
complete, you can launch the newly updated Vision.

Adding and changing serial numbers

During installation, you are prompted to enter the serial number provided with the Vision program (unless 
a dongle is in use). You may need to change the serial number later to switch from an evaluation version to 
a full version, or to upgrade to a version with more available universes.

To add or change a serial number:

1. Select the command.

The Vision Preferences dialog box opens.

2. Click Serial Numbers on the Session tab.

The Serial Number dialog box opens.

3. Enter the serial number exactly as it appears on the label. The serial number is case sensitive. The 
letters O and I are not used; enter the numbers 0 and 1 instead.

4. Click Save.

The Activation dialog box opens.

5. Click Activate to associate the serial number with the current workstation. 

Alternatively, click Continue in Demo mode to use Vision in demonstration mode. 

To view the license agreement, select Help > About, or click License Info on the Serial Number dialog box.

Updating the dongle

If using a dongle, it may need to be updated to run the latest version of Vision. You can check whether the 
dongle license is up to date, and update the dongle expiration date based on your maintenance program.

Command Path
Vision Preferences Edit

Command Path
Update Dongle • Help (Windows)

• Vision (Mac)
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To check on your maintenance program and update the dongle:

With the dongle inserted, select the command.

Alternatively, run the VisionUpdater program from the Vision application folder.

The Vision Updater dialog box opens and indicates whether your dongle license is up to date. The 
number of available universes and the dongle expiration date are displayed.

Updating the content library

The Vision content library can be updated from within Vision.

To check for and apply a library update:

Select the command.

If an update to the content library is available, it is automatically downloaded and applied.
~~~~~~~~~~~~~~~~~~~~~~~~~
Using Vision with Vectorworks
Vision basics
Setting Vision preferences

Using Vision with Vectorworks
Vision software is designed to work with Vectorworks Spotlight software, although Vision can also be used 
as a stand-alone product. For information on Vectorworks, please visit vectorworks.net. For information on 
using the Vectorworks program, please refer to the Vectorworks online help system. 

Command Path
Update Library • Help (Windows)

• Vision (Mac)

http://www.vectorworks.net
http://help.vectorworks.net
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General modeling techniques
Vision relies on properly created models to optimize previz. Efficiently created files run faster and have 
better results.

When modeling, use the fewest number of polygons possible. A high-polygon item that only represents a 
small part of the scene (such as a set piece) is an inefficient use of polygons. If an item represents only an 
inch or two of screen real estate, it is better to create it as a low-polygon item.

Use textures to create a model that has a low polygon count but still looks great. Applying detailed textures 
to low-polygon objects can give them a realistic appearance that rivals high-polygon scenes; see Object and 
fixture parameters. For more detailed information on how to use textures, see the documentation for your 
modeling software.

Preventing instability

Occasional instability problems may occur during rendering, depending upon the capabilities of the 
computer in use. To avoid crashing, ensure that the command is selected and displays with a check mark. 
Deselect the command for slightly faster rendering if your system has not presented any issues. 

Command Path
Check VRAM Render

Send to Vision

Select Vision 
video source Lighting device 

fixture modes Symbol libraries

Dongle 
driver Driver

Emulator on 
Windows/

Mac

Lighting 
console

DMX

Scene geometry

Serial 
number
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~~~~~~~~~~~~~~~~~~~~~~~~~
Vision basics

Vision basics
The application window
The Vision application window contains the scene (displayed within the Scene window in either a single 
viewport or in four viewports), the Scene Graph palette, the Properties palette, and the Tool bar, which 
contains the tool sets. Palettes and tool sets may be opened, closed, and moved around as necessary. 
When the application closes, the latest workspace settings are restored for the next session.

The Scene Graph, Properties, and Software Console palettes can be opened from the Window menu. Click 
the Maximize button, or double-click the palette title bar, to undock the palette.

Drag an undocked palette back into the Vision window to dock it as a tabbed palette. Drag the palette 
again, or double-click the palette title bar, to return the palette to the original docked location.

Scene Graph 
palette

Scene window Scene viewports

Properties 
palette

Tool bar

Video input 
status

Close

Maximize 
(Undock)
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The Tool bar

The Tool bar consists of four tool sets containing commonly used tools; see Adjusting the view and 
Modifying scene objects and fixtures. 

To display the Tool bar, select the command.

Click at the top of a tool set to undock it, and drag it to the desired location.

Customizing the display
The tool set context menu provides options for customizing the user interface. Right-click on any tool set to 
open the context menu, and select the desired options. 

Command Path Shortcut
Tools Window • Ctrl+Shift+T (Windows)

• Cmd+Shift+T (Mac)

Menu command Description
Scene Graph Displays the Scene Graph palette
Properties Displays the Properties palette
Select Displays the Select tool set
Camera Displays the Camera tool set
Modify Scene Displays the Modify Scene tool set
Modify Object Displays the Modify Object tool set

Tabbed palettes

Undock

Camera 
tool set
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~~~~~~~~~~~~~~~~~~~~~~~~~
Opening files
Merging files
Saving files
Exiting Vision
Common functions
The Scene window
Preferences
Editing the scene

Data exchange for previsualization
GDTF and .mvr files enable a seamless exchange of data between modeling programs, lighting consoles, 
and visualizers such as Vision. GDTF (General Device Type Format) is used to save and transfer custom 
fixture data. 

You can download .gdtf files from the GDTF Share or create your own in the online Fixture Builder. See 
the GDTF Help for more information about these platforms. 

GDTF files cannot be imported directly in Vision, but only as part of an MVR (My Virtual Rig) import. MVR 
files enable the transfer of all scene objects and parameter data. See Merging files for more information 
about MVR. 

Dark Theme Applies a dark color theme across the user interface. This is especially 
useful when Vision is running in a dark environment.

Tool bar Controls the appearance of tool icons and text
Icons Only Displays only an icon for each tool
Text Beside Icons Displays a text label on the right side of each tool icon
Text Below Icons Displays a text label below each tool icon
Small/Medium/Large 
Icons

Sets the size of tool icons

Grayscale Tools Displays the tool icons in grayscale. Deselect the option to display the tool 
icons in full color.

Widgets Controls the display of editable fields in the Properties palette and in the 
Vision Preferences and Document Preferences dialog boxes.

The mouse wheel, arrow keys, and Page Up/Page Down keys can be 
used to adjust the numerical parameter values controlled by text 
fields, sliders, and dials.

Text & Sliders Displays text fields and sliders
Dials & Text Displays dials and text fields.

Dials are smaller than sliders; use dials to save screen space.
Text Only Displays text fields

Menu command Description

https://gdtf-share.com/
https://fixturebuilder.gdtf-share.com
https://gdtf-share.com/help/en/help/gdtf_builder/index.html
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Setting the fixture type for MVR import
When importing a .mvr file from Vectorworks, you have the option to use GDTF fixtures or Vision fixtures, 
but it is also possible to use both in one scene. In Vision, this option is set by the Use Fixture Types from 
parameter in the Import options dialog box. However, the fixture import also depends on the fixture 
mode(s) specified in Vectorworks. 

For more information on fixture modes in Vectorworks, navigate to help.vectorworks.net and refer to 
the section on “Lighting device properties.”

Set the parameters in Vectorworks and Vision for the desired fixture import:

• To use only GDTF fixtures: 

• In Vectorworks, there is no need to specify a fixture mode. 

• In Vision, select GDTF as the fixture type. GDTF files are created for all fixtures in the scene, even 
if no GDTF Fixture Mode is specified in Vectorworks.

• To use only Vision fixtures: 

• In Vectorworks, specify the Fixture Mode. You can also specify the GDTF Fixture Mode or set it 
to None. 

• In Vision, select Vision as the fixture type. 

• To use a mix of GDTF and Vision fixtures: 

• For fixtures that should use GDTF data: In Vectorworks, specify only the GDTF Fixture Mode and 
set the Fixture Mode to None. 

• For fixtures that should use Vision data: In Vectorworks, specify the Fixture Mode. You can also 
specify the GDTF Fixture Mode or set it to None. 

• When importing the mixed file in Vision, select Vision as the fixture type.
~~~~~~~~~~~~~~~~~~~~~~~~~
Opening files
Merging files
Import options
Updating GDTF fixtures

Opening files
Vision opens .mvr, .v3s, .3ds, .obj, and .esc files that were created or saved in Vision, or exported from 
another program such as Vectorworks. Consider the advantages of Merging files instead.

When .mvr, .3ds, and .obj files are opened, the Use Normals setting on the Document preferences: 
Rendering tab is enabled by default, even if it was previously deselected. If the normals are incorrect, 
they can be fixed when setting the Import options or by Adjusting the normals.

The three most recently opened files are listed in the File menu. Select a file to open it.

If a file was sent from the Vectorworks program using the Send to Vision command, Vision launches 
automatically and opens the file. 

http://help.vectorworks.net
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To open an existing file:

1. Select File > Open.

2. Select the file to open, and click Open.

Depending on the selected file format, the Import options dialog box opens. 

3. Specify the import options.

To create a new file:

Select File > New.

A new, blank file opens.
~~~~~~~~~~~~~~~~~~~~~~~~~
Import options
Merging files
Saving files

Merging files

Vision can merge .mvr, .3ds, .obj, .v3s, and .esc files. Merging .mvr files is recommended for updating the 
Vision model with changes exported from Vectorworks. MVR (My Virtual Rig) uses unique IDs (UUIDs) to 
track the scene contents. This allows Vision to apply edits from a merged .mvr file without duplicating the 
original scene geometry. Applicable edits include new content and any changes to the position, rotation, 
and patching of existing items. The scene contents are imported as separate items, which can be selected 
and edited individually in Vision.

If Update Existing MVR Objects is deselected in the Import options dialog box, all geometry in the 
merged .mvr file will be imported without unique IDs. This means that any pre-existing geometry in the 
open scene file will be duplicated, not updated.

Like MVR, .esc files can be used to import controllable light fixtures and their focus points. A unique benefit 
of .esc files is the ability to transfer customized fixture data such as gobo wheels, lamp rotations, and 
shutter cuts. However, for organizational purposes, merging by ESC requires that you group the scene 
contents into separate files when exporting from another program. For example, to organize by truss, 
merge a separate exported file for each truss and its attached lights. To organize by DMX transform, merge 
a separate exported file for objects and fixtures that should transform together. 

To merge a file:

1. Select the command.

2. Select the file to merge, and click Open.

Depending on the selected file format, the Import options dialog box opens. 

3. Specify the import options. 

Command Path
Merge File
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When a file is merged in Vision, it displays as a heading, or “layer,” in the Scene Graph palette. Drag and 
drop the layer to the desired location (see Organizing the scene contents). When a layer is selected, all 
items contained in that layer can be moved and transformed as a group. 
~~~~~~~~~~~~~~~~~~~~~~~~~
The Scene Graph palette
Data exchange for previsualization
Import options
Opening files
Saving files

Import options
When certain file formats are opened or merged in Vision, the Import Options dialog box opens. The 
available options depend on the file format.

Click to show/hide the parameters.

Parameter Description
Mesh Smoothing Select how mesh smoothing is applied to imported objects.

• Imported: Determines whether objects appear faceted or smooth based 
on the normals in the imported file (the normals are not recalculated).

• Custom Crease Angle: Determines whether objects appear faceted or 
smooth based on the specified Crease Angle (the normals are 
recalculated).

• None: Forces all objects to appear flat or faceted (the normals are 
recalculated).

Crease Angle When Custom Crease Angle is selected, enter the desired angle to smooth all 
mesh objects rendered with OpenGL; enter a higher value for smoother 
surfaces (range: 0–180)

Units in File Select the units for the imported file; this affects the size of the imported 
objects

Use Fixture Types from
(MVR only)

Select the type of fixture to use: GDTF or Vision. It is also possible to use both 
fixture types in a scene. 
The fixture import depends on the Use Fixture Types from setting, as well as 
the fixture mode settings made in Vectorworks. See Setting the fixture type 
for MVR import.

When GDTF fixtures are imported, some of their parameters are disabled 
on the Properties palette, and all GDTF fixtures are disabled in the Patch 
dialog box.

Truss Material
(MVR only)

Select the truss material, or select Imported to apply truss materials from the 
imported file
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~~~~~~~~~~~~~~~~~~~~~~~~~
Document preferences: Rendering tab
Data exchange for previsualization
Opening files
Merging files
Saving files

Saving files
Each Vision file should be saved within a unique folder. The textures associated with a Vision file must have 
unique names; the textures are named according to the containing folder. Do not save two Vision files in 
the same folder, as this causes them to share a textures folder, with unpredictable results. 

To save a file:

Select File > Save. 

To save the file with a different name or to a different location:

1. Select File > Save As.

2. Specify the file name and location, and click Save. The file format is .v3s.

If a file was sent from the Vectorworks program using the Send to Vision command, it is 
important to save the file in Vision immediately. If you close Vision without saving the file, it is 
lost.

~~~~~~~~~~~~~~~~~~~~~~~~~
Exiting Vision
Common functions

Exiting Vision
To close the Vision program along with the open file:

Select File > Exit (Windows) or Vision > Quit Vision (Mac).

Coordinate System Select the coordinate system for the imported file:
• Vectorworks (right-handed, Z-up, Y-forward)
• Vision (left-handed, Y-up, Z-forward)

Select Vectorworks if the file was exported from the Vectorworks 
program.

Flip Moving Lights Rotates all moving light fixtures by 180 degrees on the X axis, so Vectorworks 
content can be oriented correctly in Vision

Update Existing MVR 
Objects
(MVR only)

Updates the open scene file without duplicating the existing geometry

Click here for a video tip about this topic (internet access required).

Parameter Description

https://www.youtube.com/watch?v=Mc_Xdb6Pv54
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~~~~~~~~~~~~~~~~~~~~~~~~~
Opening files
Merging files
Saving files

Common functions
The Vision program’s Edit menu commands perform operations common to most software programs.

• Undo/Redo: Undoes or redoes the last performed action.

• Cut/Copy/Paste: Cuts or copies an item to the clipboard; pastes the item from the clipboard.
~~~~~~~~~~~~~~~~~~~~~~~~~
Opening files
Merging files
Saving files

The Scene window

The scene file contains the geometry that represents fixtures, trusses, pipes, set pieces, venue walls, and so 
on. The Scene window displays the scene file, and it is where visualization occurs. 

Drag the divider along the edge of the Scene window to adjust the amount of space taken up by the Scene 
window and any open palettes.

The Scene window can be viewed as a single viewport or as four viewports, each with a different view.

Four viewports are helpful when setting up a complex focus with many fixtures at odd angles.

Command Path Shortcut
Toggle Number of Viewports Window M

Drag the 
divider to 
adjust the size 
of the palettes 
and the Scene 
window
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To toggle the number of viewports in the Scene window, select the command.

Full screen view

The Toggle Fullscreen command toggles between a maximized full screen of the bottom right viewport and 
the normal, resizable display of the Vision program.
To switch to full screen view:

1. Select the command.

The bottom right viewport expands, filling the entire screen.

2. To exit full screen view, press the Esc key, or press the keyboard shortcut again.

Ambient light in the Scene window
In Vision, ambient lighting simulates the house lights in an indoor scene or the natural lighting in an outdoor 
scene. To set the azimuth or elevation of ambient light, see the Document preferences: Environment tab.

Ambient Intensity controls the brightness of ambient light throughout the scene, and Exposure controls 
the perceived brightness—mimicking the camera’s or the eye’s adaptation to changing light levels. These 
settings can be adjusted from the Document preferences: General tab or the Properties palette. 

The Ambient Intensity can also be adjusted manually using keyboard shortcuts.

• To increase the setting by 1, press Ctrl+Shift+L (Windows) or Cmd+Shift+L (Mac); to decrease the 
setting by 1, press Ctrl+Shift+K (Windows) or Cmd+Shift+K (Mac).

• To toggle the setting by 50, press Ctrl+Shift+J (Windows) or Cmd+Shift+J (Mac). If the Ambient 
Intensity is less than 50, the toggle increases the setting by 50. If the Ambient Intensity is 50 or 
more, the toggle decreases the setting by 50.

Looked At point

Each viewport in the Scene window includes a Looked At point to indicate where the camera is looking. All 
zooming and rotation operations are based on the Looked At point; it is the center of rotation for the 
Flyover tool. Use the tools in the Camera tool set to move the Looked At point. The Push Looked At 
Distance parameter on the Vision preferences: Interactive tab sets the minimum distance from the camera 
to the Looked At point. This distance can be adjusted to optimize close-ups or distant views. 

To toggle the Looked At point on and off, select the command.

Command Path Shortcut
Toggle Fullscreen Window • Ctrl+Shift+F (Windows)

• Cmd+Shift+F (Mac)

Command Path Shortcut
Toggle Looked At Point Window • Ctrl+Shift+O (Windows)

• Cmd+Shift+O (Mac) 
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Grid view

The Toggle Grid command toggles the display of a grid in the Scene window. The grid center is the 
document origin, and each square of the grid measures 5 feet by 5 feet. When viewing the Scene window as 
four viewports, the command applies to all viewports.

To display the grid, select the command.

Scene window rendering

Each viewport can display as a solid or wireframe rendering.

To set the rendering of a viewport:

Right-click on the viewport and select the desired command.

Scene window standard views
Each viewport in the Scene window can display in one of nine preset views, or in a custom view that can be 
saved (see Saving views). The label in the top left corner of the viewport indicates the current view; “User” 
designates either a custom view or one of the isometric preset views.

The six standard preset views can be accessed from the viewport context menu; right-click on the viewport 
and select one of the views. Alternatively, use the shortcut keys on the numeric keypad to access the 
standard and isometric views. Isometric views are labeled as User views.

Click to show/hide the parameters.

Command Path Shortcut
Toggle Grid Window • Ctrl+Shift+G (Windows)

• Cmd+Shift+G (Mac) 

Command Path
• Wireframe
• Solid

Context menu

View Numeric keypad 
shortcut

Available on 
context menu

Front Left Isometric 1 No
Front 2 Yes
Front Right Isometric 3 No
Left 4 Yes
Top 5 Yes
Right 6 Yes
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Saving views
A custom view can be saved and restored later. Up to nine Scene window views can be saved with the file. 
Use the keyboard numbers for these operations; do not use the numeric keypad, which controls the Scene 
window standard views.

To save a view:

1. Click the viewport with the view to save.

2. Press the Ctrl key (Windows) or Cmd key (Mac), and any number key (1–9) on the keyboard. 

The current viewport view settings are saved to the keyboard shortcut.

To restore a view:

Press the designated number key (1–9) to restore the saved view. 

If the saved views do not display as expected, they can be reset. To reset all views:

Right-click on the viewport and select Set Default Views from the context menu. The saved views 
are replaced with the standard preset views.

~~~~~~~~~~~~~~~~~~~~~~~~~
Adjusting the view
Setting the DMX provider
Editing the scene

Adjusting the view
Use the Camera tools to adjust the view.

Flying over

The Flyover tool simulates movement over and around a real-world scene. The center of rotation is the 
Looked At point.

To fly over a scene:

1. Click the tool.

2. Within the viewport, click and drag in the direction of movement while holding down the mouse 
button.

Rear Left Isometric 7 No
Back 8 Yes
Rear Right Isometric 9 No

Tool Tool set Shortcut
Flyover Camera Shift+C

View Numeric keypad 
shortcut

Available on 
context menu
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The viewport label displays “User,” since the view is a custom view and not one of the preset views.

The Flyover tool can be used in boomerang mode if you have a center mouse button. Hold down 
Ctrl+center mouse button (Windows) or Cmd+center mouse button (Mac) to temporarily pause the current 
tool and switch to the Flyover tool. Release the buttons to return to the previous tool.

Zooming

The Zoom tool controls how close or far away objects appear in the viewport. Zoom in to get a close-up 
view of a detail, and zoom out to get a broader view of the scene. 

Zooming is based on the Looked At point, not the mouse location. The speed of zooming depends on the 
Push Looked At Distance specified on the Vision preferences: Interactive tab. 

To zoom in or out of a viewport:

1. Click the tool.

2. Within the viewport, click and drag while holding down the mouse button. Move the cursor up to 
zoom in on the viewport, or move the cursor down to zoom out of the viewport.

On a wheel-mouse, roll the mouse wheel forward to zoom in on the viewport (the Zoom tool does not need 
to be selected). Roll the mouse wheel backward to zoom out from the viewport.

This feature will not work properly if standard scrolling is disabled in the mouse setup. For example, if the 
mouse’s scrolling size is set to “none,” mouse zooming in Vision is disabled. (The specific settings required 
for this feature depend on the type of mouse.)

Panning

The Pan tool moves the scene around in the viewport, changing the area of display. 

To pan within the viewport:

1. Click the tool.

Alternatively, depending on the type of mouse being used, press and hold the center mouse button 
to pan.

2. Within the viewport, click and hold the mouse button, and drag to move the scene.

The Pan tool can be used in boomerang mode. Hold down the Space bar or the center mouse button, if you 
have one, to temporarily pause the current tool and switch to the Pan tool. Release the Space bar or the 
mouse button to return to the previous tool.

Tool Tool set Shortcut
Zoom Camera C

Tool Tool set Shortcut
Pan Camera H
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Fitting the view to objects

The Fit To Objects tool changes the view to zoom to the selected objects. When the Scene window displays 
four viewports, this tool applies only to the bottom right viewport.

To fit the view to objects:

1. Select one or more objects. 

To fit the zoom level to all objects in the Scene window, select ROOT from the Scene Graph palette.

2. Click the tool.

The zoom level adjusts to the selected objects.
~~~~~~~~~~~~~~~~~~~~~~~~~
The Scene window
Editing the scene
Setting the DMX provider

Setting the DMX provider

To properly communicate with a connected console, specify the DMX protocol. See the Community Forums 
for specific information about DMX connectivity. Some DMX providers limit the number of universes.

A Vision dongle is required to use MA-Net2.

To set the DMX provider:

1. Use an Ethernet cable to connect the console to the Vision computer. Configure the computer’s IP 
address and Sub-net Mask according to your lighting controller’s specifications. Some consoles 
provide utilities for this configuration; consult the console documentation. Make sure your firewall 
is off temporarily while selecting the provider, and then re-enable it.

2. Launch Vision.

3. Select the command.

The Select DMX Provider dialog box opens.

4. The currently selected protocol displays with an asterisk. Select a different protocol from the list if 
needed. The availability of protocols in the list depends on the platform.

Tool Tool set
Fit To Objects Camera

Command Path
Change DMX Provider DMX

https://forum.vectorworks.net/index.php?/topic/45676-dmx-connectivity-articles/
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Configuring multiple input devices

Vision allows multiple DMX input devices to be configured and used at the same time, so you can visualize 
several different types of DMX input simultaneously.

Multi Input is limited to 64 universes.

To configure multiple input devices:

1. Select the command.

The Select DMX Provider dialog box opens.

2. Select MultiInput as the DMX protocol.

The DMX Source Selection dialog box opens.

3. Connect any of the DMX universes within Vision by selecting the universe, and then selecting the 
DMX protocol from the list.

Preferences
Setting Vision preferences

Vision preferences are options that apply to every file you open, every time you run the program. The 
settings can be saved and managed from any tab in the Vision Preferences dialog box; see Using saved sets. 

To change the Vision preference settings:

1. Select the command.

The Vision Preferences dialog box opens.

2. Click each tab to set the preferences. Click Apply to apply the settings while keeping the Vision 
Preferences dialog box open.

Vision preferences: Graphics tab
Click the Graphics tab to set preferences that control graphics and display.

Click to show/hide the parameters.

Command Path
Change DMX Provider DMX

Command Path
Vision Preferences Edit

Parameter Description
Resolution Quality Sets the maximum screen resolution for the Scene window. 

If the Scene window resolution is smaller than the specified value, 
Vision uses the Scene window resolution when rendering.
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Vision preferences: Interactive tab
Click the Interactive tab to set preferences for the display of interactive drawing features, such as the grid, 
selection boxes, and Looked At point.

Click to show/hide the parameters.

Texture Quality Sets the quality level for textures and controls their resolution. Higher 
quality results in more detail but slower rendering.

Shadow Quality Sets the quality level for shadows. Higher quality results in more accurate 
shadows but slower rendering.

Surface Light Quality Sets the quality level for light emitted from a fixture. Higher quality 
results in more accurate beams and surface lighting, but slower 
rendering.

Dynamic Shadows Specifies which items cast shadows in the scene.
• Objects & Fixtures: All objects and fixtures cast shadows.
• Objects: All objects cast shadows, but fixtures do not.
• None: All static objects cast shadows, but dynamic fixtures and objects 

do not.

If the Texture Quality is Medium, High, or Very High, all objects 
become dynamic, and shadows display only if Objects & Fixtures or 
Objects is selected. 

Render Fixtures Specifies whether or not fixtures are rendered, or rendered in black
Gamma Adjusts the contrast and brightness of midtone colors, without changing 

black or white
Haze Quality Sets the rendering quality of the light beams, but does not control the 

intensity of the beams
Enable VSync It is recommended that you enable VSync to prevent “tearing” and other 

graphical inconsistencies, and to save battery life.
Disabling VSync may improve performance, but it should only be done for 
testing purposes.

Parameter Description
Display Grid Displays the grid in all viewports
Display Looked At Point Displays the Looked At point in all viewports
Display Selection Displays the bounding box of the selected object(s)
Push Looked At Distance Sets the minimum distance from the camera to the Looked At point. 

Larger values optimize distant views and enable faster navigation through 
the scene. Smaller values optimize close-up views and small camera 
movements. 
Vision moves the Looked At point to maintain the specified distance when 
Zooming.

Parameter Description
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Vision preferences: Session tab
Click the Session tab to set the error reporting preferences, view the license information, and add or change 
serial numbers.

Click to show/hide the parameters.

~~~~~~~~~~~~~~~~~~~~~~~~~
Setting document preferences
Editing the scene
DMX transforms
Assigning textures
Saving the scene as an image
Saving the scene as a movie
Using DMX controls
The DMX recorder

Parameter Description
Error Reporting Sends anonymous information about application crashes and other basic 

usage statistics to Vectorworks to help improve the software. Four levels of 
informational detail can be selected.
• Send nothing: When you activate Vision software, we always collect 

general data about the operating system, graphics card, monitor 
resolution, and Vision version.

• Send crash details: In addition to the general information that is always 
collected, this allows us to receive additional information in the event of a 
crash, including idle time, alerts received, and graphics card operations 
prior to the crash.

• Send crash details and light usage patterns: Selecting this option 
invaluably assists us with product development while maintaining user 
privacy. In addition to the previously listed information, we are able to 
duplicate actions taken before a software crash, review undo actions, 
determine which objects may have been selected, and view 
Vision-related file paths. We cannot see the data in your scenes, and the 
reporting has no impact on your software operations. Reporting happens 
in the background as you work and should not affect your workflow.

• Send crash details and verbose usage patterns: Selecting this option 
invaluably assists us with product development while maintaining user 
privacy. In addition to the information gathered through the light usage 
pattern option, we are able to upload additional information such as tool 
and command selection. We cannot see the data in your scenes, and the 
reporting has no impact on your software operations. Reporting happens 
in the background as you work and should not affect your workflow.

Serial Numbers Opens the Serial Number dialog box to add or change a serial number for the 
Vision product (see Adding and changing serial numbers).
Click License Info to view the license agreement.
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Setting document preferences

Document preferences only apply to the current drawing, and they remain in effect until they are changed. 
The settings can be saved and managed from any tab in the Document Preferences dialog box; see Using 
saved sets. When a .esc or .mvr file is opened in Vision, the most recent settings are applied.

Document preferences can also be set from The Properties palette.

To change the preference settings in the document:

1. Select the command.

The Document Preferences dialog box opens.

2. Click each tab to set the preferences. Click Apply to apply the settings while keeping the Document 
Preferences dialog box open.

Document preferences: General tab
Click the General tab to set various display preferences.

Click to show/hide the parameters.

Command Path
Document Preferences File

Parameter Description
Ambient Intensity Sets the amount of light in the entire scene when fixtures are off. 

No shadows are created by ambient lighting. To adjust the 
ambient light level using keyboard shortcuts, see Ambient light in 
the Scene window.
To modify the color and brightness of ambient light, set the 
Ambient Color from the Document preferences: Environment tab.

Exposure Controls how much light enters the virtual camera lens. Values 
above 1.00 increase the exposure and values below 1.00 decrease 
it.

The default setting of 1.00 is best for most scenes, but you 
may want to adjust for final rendering. Check the target lux 
values on the Document preferences: Heat Map tab, then 
modify the exposure as needed.

Haze Intensity Controls the amount of haze, making light beams more or less 
intense.

For faster rendering, disable light beams by setting the Haze 
Intensity to 0%.

Contrast Controls the difference between light and dark areas in the scene. 
Increasing this value makes the difference more intense, while 
decreasing it can add a washed-out effect.
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Document preferences: Rendering tab
Click the Rendering tab to set the rendering preferences.

Click to show/hide the parameters.

Brightness Controls brightness in the scene by adjusting the comparative 
luminance of each pixel.

The default setting of 0 (zero) is best for most scenes. To 
modify the overall scene lighting, first adjust the Ambient 
Intensity, then the Exposure, and finally the Contrast or 
Brightness if needed.

Camera FOV Sets the horizontal field of view in the scene. Increase the value to 
widen the field of view, and decrease the value to narrow it.

Parameter Description
Use Normals Enables advanced lighting when valid normals are present. 

Normals indicate which direction the scene geometry is facing, to 
troubleshoot rendering issues. Select Render Normals to view the 
normals in the drawing.

When .3ds and .obj files are opened, this setting is enabled by 
default.

Use Face Culling For better performance, renders only the camera-facing geometry. 

If geometry displays incorrectly, try Adjusting the winding 
order.

Diffuse Strength Multiplies the intensity of diffuse lighting, which has the same 
brightness no matter the camera view. 

Use this setting primarily for testing. To adjust the amount of 
diffuse lighting, modify the Ambient Intensity or Exposure 
instead.

Specular Strength Makes objects appear shinier by brightening their highlights. 

Use this setting primarily for testing. To increase or decrease 
the amount of specular highlighting, adjust the Exposure 
instead.

Bump Strength Multiplies the intensity of the bump effect for all textures.

To finely adjust the bump strength, modify the grayscale 
shades in the bump texture image.

Parameter Description
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Render Normals Indicates the normals of the scene geometry by rendering them as 
RGB colors. The colors adjust to the camera view.
• Red indicates left-facing normals.
• Green indicates top-facing normals.
• Blue indicates front-facing normals.

If an object is reflecting light incorrectly, its normals might be 
inverted; try Adjusting the normals.

Render Specular Uses color coding to indicate the specular reflectivity of objects 
(metallic objects should use the metal’s color). 
• White indicates high reflectivity.
• Black indicates no reflectivity.
• Gray indicates low reflectivity. An overall gray or muted 

appearance is expected if the Texture Quality is low or if a 
reflective texture image is not applied.

• Color indicates metal reflectivity.

Select the check box to test the specular lighting. For example, 
test whether a highly reflective texture is applied correctly 
when the Texture Quality is high.

Render Shadows Controls the display of shadows for all objects and layers. To 
decrease rendering time for large files or DMX transforms, 
deselect the check box. 

You can override the Render Shadows preference for specific 
items in the scene; set the Cast Shadows parameter on The 
Properties palette to toggle shadows on or off for selected 
objects and layers.

Send NDI Stream Outputs a live NDI stream of Vision.

Select this option to send an NDI stream of Vision to Disguise 
EVO, a media server, a video-sharing platform, and so on.

Render Video Controls how video screens are rendered.
• On: Enables video playback.
• Screen Test Image: Displays the screen images specified by 

Vectorworks when the .mvr file was exported. If no images 
were specified, the screens appear gray.

• Render Video with Disguise: Blacks out the video screens, so 
Disguise can render video.

• Off: Blacks out the video screens.

The options Render Video with Disguise and Off perform the 
same function; select either option to stop rendering video 
screens in Vision.

Parameter Description



26 | Preferences
Document preferences: Environment tab
Click the Environment tab to set preferences for the environment lighting.

Click to show/hide the parameters.

Far Clip Plane Distance Sets the distance (in inches) to the far clip plane, which is the 
boundary of the visible scene. All items within the Far Clip Plane 
Distance are visible, while items beyond this distance are “clipped” 
out of view. Lower distance values can improve shadow quality, so 
extremely high values are not recommended. 
To set the optimal distance for your scene, zoom out to the 
furthest extent required for previz. Decrease the Far Clip Plane 
Distance until some geometry is clipped from view, and then 
gradually increase the distance until no clipping occurs.

Parameter Description
Ambient Color Sets the color of ambient lighting—for example, to mimic sunrise 

or moonlighting. Click the button next to the color definition. The 
Color Picker dialog box opens. Choose a color from the color 
picker. The Preview displays the selected color. The Hue, 
Saturation, and Luminance values display, as well as the Red, 
Green, and Blue values.

Background Color Sets the background color, if no Panoramic Background is 
specified. Click the button next to the color definition. The Color 
Picker dialog box opens. Choose a color from the color picker. The 
Preview displays the selected color. The Hue, Saturation, and 
Luminance values display, as well as the Red, Green, and Blue 
values.

Parameter Description
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Document preferences: Haze tab
Click the Haze tab to set the haze preferences. 

Click to show/hide the parameters.

Panoramic Background The panoramic background is a composite of six images. These 
images are saved individually but together form a “cube map.” 
When the component images are properly named and aligned, as 
shown below, Vision renders them as a seamless background 
image.

The component images may need to be inverted or rotated for 
proper alignment. 

Each image must have the same name but with a special suffix 
denoting which side of the cube it represents. All images must be 
saved in the same format, such as .png or .jpg.
• Front: Name_ft 
• Back: Name_bk
• Left: Name_lf
• Right: Name_rt
• Up: Name_up
• Down: Name_dn
Select one of the component images of your desired panoramic 
background; Vision will locate the other images to form the cube 
map. Click the button to select an image file; click X to remove the 
file.
Some panoramic backgrounds are provided with the Vision 
application; see the “lo” .jpg files and “midnight-silence” .png files 
in the textures/App folder.

Sun Azimuth Sets the azimuth for ambient lighting, when orbiting the ambient 
lighting around the scene.
South is at 0 degrees, West is at 90 degrees, North is at 180 
degrees, and East is at 270 degrees.

Sun Elevation Sets the elevation (degrees above the horizon) for ambient lighting

Parameter Description
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Document preferences: Bloom tab
Click the Bloom tab to set the bloom preferences.

Click to show/hide the parameters.

Parameter Description
Haze Style Select the type of haze for the light beams.

The 4D haze options use a procedurally-generated haze 
texture that can move in 3D space and time.

• None: No haze texture is applied.
• Low-Quality Haze Texture: The specified Haze Texture is 

applied with low quality. The texture image does not adjust to 
camera movement.

• Low-Quality 4D Haze: A 4D haze texture is applied with low 
quality.

• High-Quality 4D Haze - Half Resolution: A 4D haze texture is 
applied with high quality and rendered at half resolution.

• High-Quality 4D Haze - Full Resolution: A 4D haze texture is 
applied with high quality and rendered at full resolution; 
performance may decrease.

Haze Texture For a Haze Style with Low-Quality Haze Texture, select a haze 
image. The image is applied where a light beam projects in the 
scene.

Haze Texture Intensity Controls the intensity of the haze texture for all haze styles. At 0%, 
no texture is applied; at 100%, white areas of the texture have 
haze and black areas have none.

Haze Horizontal/Vertical Speed Controls the speed of the haze as it moves horizontally and 
vertically

Haze Depth Speed
(4D Haze only)

Controls the speed of the haze as it moves forwards and 
backwards, relative to a front view

Haze Turbulence
(4D Haze Only)

Controls how fast the haze texture varies

Haze Horizontal/Vertical Offset
(Low-Quality Haze Texture 
only)

Sets a horizontal or vertical offset for the haze image. The offset 
corresponds to screen percentage; for example, an offset of 10% 
shifts the haze image by 10% of the screen or Scene window.

Haze Contrast
(Low-Quality Haze Texture 
only)

Controls the difference between light and dark pixels in the haze 
image

Haze Scale
(4D Haze only)

Controls the size of the haze features. At large scale, the haze 
appears cloudy; at small scale, many small wisps display in the light 
beam.
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Document preferences: Heat Map tab
Click the Heat Map tab to set the heat map preferences.

Click to show/hide the parameters.

~~~~~~~~~~~~~~~~~~~~~~~~~
Setting Vision preferences
Editing the scene
DMX transforms

Parameter Description
Bloom Percentage Sets the intensity of the bloom effect. This adds a glow to the 

brightest areas of the scene, like a bright light overwhelming the 
camera or eye. A value of 0 (zero) disables the bloom.

Bloom Threshold Sets the lighting level where bloom occurs
Bloom Lens Strength Modifies the intensity of the bloom effect for fixture lenses; at 0 

(zero), lenses are not rendered

Parameter Description
Heat Map Style Select the type of heat map to display.

• None: Displays the normally rendered scene with no heat map.
• Black and White: Displays a black and white heat map. This 

option sets the Heat Map Min/Max Lux to the same threshold 
value. Black areas in the scene have less illumination than this 
value. White areas have the same or more illumination than 
this value.

From the Properties palette, you can identify the lux value in a 
part of the scene by scrolling to increase and decrease the 
threshold value; when a part of the scene switches between 
black and white, its illumination matches the threshold value.

• Color Gradient: Displays a color heat map. Illumination is 
represented by a blend of colors ranging from black as the Heat 
Map Min Lux to white as the Heat Map Max Lux.

Heat Map Min Lux Set the minimum lux value for the heat map
Heat Map Max Lux Set the maximum lux value for the heat map

Click here for a video tip about this topic (internet access required).

Minimum lux Maximum luxHeat map color scale

https://www.youtube.com/watch?v=ay6xBX7M3kc
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Assigning textures
Saving the scene as an image
Saving the scene as a movie
Using DMX controls
The DMX recorder

Using saved sets
You can save the specified settings for reuse, and edit or delete saved sets.

Click to show/hide the parameters.

~~~~~~~~~~~~~~~~~~~~~~~~~
Setting Vision preferences
Setting document preferences
Saving the scene as an image
Saving the scene as a movie
Editing the scene

Editing the scene
The Scene Graph palette

The Scene Graph palette displays an organized list of scene items for selection. Use the Scene Graph palette 
to select items in the scene, to select objects and fixtures for editing in the Properties palette, or to select 
conventional fixtures for fine adjustments in the Software Console palette. The Scene Graph palette’s 
context menu provides options for organizing the scene contents and troubleshooting display issues.

Parameter Description
Settings Displays the name of the current saved set; to use a different 

saved set, select it from the list of saved sets.

Any set in the list with angle brackets indicates either a Vision 
default or a variable set, not a saved set. For example, <Active 
Settings> refers to the dialog box’s current parameters, which 
are not saved as a set.

Save Opens the Save Settings dialog box to name and save the current 
parameter settings; the saved set is added to the Settings list

Manage Opens the Manage Saved Sets dialog box, to rename or delete 
saved sets. Select a name from the list, and then click the 
appropriate button.

When renaming a set, if the entered name is already assigned 
to another set, you are prompted to confirm that you want to 
replace the existing set.

Command Path Shortcut
Scene Graph Window • Ctrl+Shift+R (Windows)

• Cmd+Shift+R (Mac)
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To open the Scene Graph palette:

Select the command.

The ROOT list heading, or “ROOT layer,” represents the contents of the entire scene; it contains a 
hierarchical list of layers, fixtures, and scene objects. 

Merged scene files display as layers under the ROOT layer (see Merging files). 

Click successive disclosure arrows to navigate the scene hierarchy. Press the Alt key (Windows) or the 
Option key (Mac) when clicking a disclosure arrow to expand or collapse all items in that layer.

Selected objects and fixtures are highlighted in the Scene window, and their parameters display in the 
Properties palette. When multiple items are selected, the displayed parameters depend on the first item 
selected; only that type of item displays parameters. 

Selecting global scene parameters, objects, and fixtures
To select items, you may need to expand the layers in the Scene Graph palette:

• From the Scene Graph palette, select ROOT to edit the global parameters for the entire scene (see 
Global parameters).

• Expand the ROOT layer to access items within the scene. Use the Page Up/Page Down and arrow 
keys to scroll through the main ROOT layers. When a layer is selected, all items within the layer are 
also selected, so they can be moved and transformed as a group. These items are highlighted in 
the Scene window, and their parameters display in the Properties palette.

Exact parameter values display only if they are identical for all items in the layer. When a value 
differs, this is indicated by a double asterisk (**) after the parameter name, followed by a 
blank field or a value of 0.00.
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• Keep expanding the layers until you access an individual object or fixture, to select and edit only a 
single item. The selected fixture or object is highlighted in the Scene window, and its parameters 
display in the Properties palette. Fixtures with accessories may also display parameters for gobo 
images and shutters in the Software Console palette. The displayed parameters depend on the 
fixture type and accessories.

• Multiple items can be selected by pressing the Shift key or the Ctrl (Windows) or Cmd (Mac) key 
while clicking on items in the Scene Graph palette. 

Organizing the scene contents

To organize the scene contents, insert new layers in the Scene Graph palette. You can drag and drop items 
from one layer to another. When a layer is selected, all items contained in that layer are selected, so they 
can be moved and transformed as a group. This is especially helpful when setting up DMX transforms.

To insert a layer in the Scene Graph palette:

Select an item in the list of scene contents, and select the command. 

A new layer is inserted into the selected layer, or into the layer of the selected fixture or object.

The layer can be renamed from the Properties palette.

To move a layer, click and drag it to the desired location. The ROOT layer is the highest level in the list of 
scene contents.

Correcting scene contents for previz
When objects are imported into Vision, they may need adjustment for correct display. The following 
commands apply only when certain options are selected in the document preferences.

Adjusting the normals

This command applies when Use Normals is selected on the Document preferences: Rendering tab. If an 
object does not reflect light correctly, its normals might be invalid. To view the normals, select Render 
Normals from the Document preferences: Rendering tab. 

• Left-facing normals are red.
• Top-facing normals are green.
• Front-facing normals are blue.

If an object’s normals are inverted, use the command to correct them.

To invert an object’s normals:

Select the object in the Scene Graph palette, and select the command.

Command Path
Insert Layer Context menu

Command Path
Invert Normals Context menu
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Adjusting the winding order

When Use Face Culling is selected on the Document preferences: Rendering tab, Vision uses a clockwise 
winding order to render the scene geometry. If any geometry displays incorrectly, its winding order might 
be incompatible.

Winding (in a clockwise or counter-clockwise direction) defines the order of a polygon’s vertices. The 
winding order determines which polygons are facing the camera. When the scene geometry is wound 
in the same direction, face culling can be used to render only the camera-facing geometry, for improved 
performance.

To reverse the winding order of one or more objects:

Select the object(s) in the Scene Graph palette, and select the command.

Refreshing the Scene Graph palette

You can refresh the Scene Graph palette to ensure the proper display of scene contents. 

To refresh the Scene Graph palette: 

Select the command. 

The Scene Graph palette and the Properties palette are updated.
~~~~~~~~~~~~~~~~~~~~~~~~~
Opening files
Merging files
The Properties palette
Assigning textures
Resetting video inputs
Modifying scene objects and fixtures
Focusing conventional fixtures
The Software Console palette
Saving the scene as an image
Saving the scene as a movie

The Properties palette

Command Path
Flip Winding Order Context menu

Command Path
Refresh Context menu

Command Path Shortcut
Properties Window • Ctrl+Shift+Y (Windows)

• Cmd+Shift+Y (Mac)
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From the Properties palette, you can view and edit the parameters of selected fixtures, objects, or layers. 
The available parameters depend on the items selected. Depending on the parameter, a field may be 
edited, a value toggled, or a dialog box opened. 

You can use the mouse wheel or arrow keys to change numerical parameter values by small increments; 
for larger increments, use the Page Up/Page Down keys.

To open the Properties palette:

Select the command.

Individual parameters are categorized by function. Click the disclosure arrows to expand the categories. 
Press the Alt key (Windows) or the Option key (Mac) when clicking a disclosure arrow to expand or collapse 
all items in that category. 

Use the scroll bar on the Properties palette to navigate the list, or scroll with the Page Up/Page Down and 
arrow keys. 
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When multiple items are selected, the exact parameter values display only if they are identical for all 
selected items. When a value differs, this is indicated by a double asterisk (**) after the parameter name, 
followed by a blank field or a value of 0.00. 

A parameter value of “Multiple” may display if one or more multi-part fixtures are selected. “Multiple” 
indicates that the parameter value is not identical for all parts of the fixture.

Parameters for a multiple selection of 
multi-part fixtures

“Multiple” means that, for each 
selected multi-part fixture, the 
Candela values differ for 
different parts of the fixture

No double asterisk indicates 
that 0.00 is the exact Position 
Y value for both fixtures

A double asterisk appended 
to the Position X and Z

parameters indicates that 
0.00 is a placeholder for 

heterogeneous values
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Global parameters
When no scene items are currently selected, the global scene parameters display in the Properties palette. 
To edit these parameters, select ROOT from the Scene Graph palette. 

Most, but not all, of the global scene parameters can also be edited from the Document Preferences dialog 
box. For ease of access, frequently used parameters display at the top of the Globals list in the Properties 
palette. The remaining global parameters are grouped like the tabs on the Document Preferences dialog 
box. 

Click to show/hide the parameters.

Object and fixture parameters
When scene items are selected, the parameters that display in the Properties palette depend on the type of 
item. Some parameters are available for both objects and fixtures, while others are available either for 
objects or for fixtures. Some of these parameters are also available for layers in the Scene Graph palette 
(for more information on layers, see Organizing the scene contents). 

Click to show/hide the parameters.

Global parameter Description
Globals See Setting document preferences for parameter descriptions

High Precision Enables highly accurate renderings. Deselect the check box to quickly 
render large files; the check box must be deselected each time you open 
a .v3s file. Some artifacts may appear.

Use this setting primarily for testing.

Parameter Description Availability
Name Displays the fixture’s channel number or the object’s 

name
Objects, fixtures, and 
layers

Unit Number Displays the fixture unit number Fixtures
Display Name Displays the fixture make and model; this field cannot be 

edited
Fixtures

Manufacturer Displays the fixture manufacturer; this field cannot be 
edited

Fixtures

Type Displays the fixture type; this field cannot be edited Fixtures
Visible Indicates that the fixture is visible in the scene; deselect to 

make the fixture invisible
Fixtures and layers

Universe Displays the universe assigned to the fixture Fixtures
Channel Displays the DMX address assigned to the fixture Fixtures
Num Channels Displays the number of channels in the fixture profile; this 

field cannot be edited
Fixtures
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Cast Shadows Controls the display of shadows for specific objects and 
layers, so you can override the global shadow preference 
when needed.

Set the global shadow behavior from the Render 
Shadows setting on the Document preferences: 
Rendering tab.

• Use Parent Setting: Uses the same Cast Shadows 
setting that is specified for the closest “parent” layer in 
the Scene Graph palette. This option is selected for all 
objects and layers by default, so the ROOT layer setting 
(controlled by the Render Shadows preference) is 
applied globally.

• Cast Shadows: Toggles shadows on, even when you 
deselect the Render Shadows preference.

• Do Not Cast Shadows: Toggles shadows off, even when 
you select the Render Shadows preference.

Objects and layers

Position Objects, fixtures, and 
layers

Position X Sets the item’s position on the X axis in inches. Positive 
values move right; negative values move left.

Objects, fixtures, and 
layers

Position Y Sets the item’s position on the Y axis in inches. Positive 
values move up; negative values move down.

Objects, fixtures, and 
layers

Position Z Sets the item’s position on the Z axis in inches. Positive 
values move away from the camera; negative values move 
toward it.

Objects, fixtures, and 
layers

Rotation Objects, fixtures, and 
layers

Rotation X/Y/Z Sets the item’s rotation on the X/Y/Z axis in inches. 
Positive values rotate clockwise; negative values rotate 
counter-clockwise.

Objects, fixtures, and 
layers

Scale Objects and layers
Scale X/Y/Z Sets the scale of the object in its local X-/Y-/Z-axis 

coordinate direction
Objects and layers

XForm Moves, rotates, and scales selected items in the scene, or 
all items in the selected layer. See DMX transforms for 
more information.

Fixtures cannot be scaled by DMX transform.

Objects, fixtures, and 
layers

Material Objects
Color Displays the RGB color assigned to the object Objects

Parameter Description Availability
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Texture Displays the image file, video file, or video input assigned 
to the object. Click the button next to the texture field to 
select a file. Click X to remove the file. 
For more information on adding video to textures, see 
Assigning textures.

Objects

Use Alpha 
Channel

Uses the alpha channel from the Texture as the rendering 
mask

Objects

Texture Scale Sets the texture size on an object. For example, a scale 
value of 2 doubles the size of the texture. 

Objects

Texture Offset H/
V

Shifts the start location of the texture horizontally or 
vertically

Objects

Brightness Controls the brightness of the texture by adjusting the 
comparative luminance of each pixel in the texture image; 
this is useful for video screens

Objects

Specular Texture Uses a color image to control the color and intensity of the 
object’s reflectivity, depending on the amount of surface 
detail and the Specular Power. Click the button next to 
the texture field to select a texture image file. Click X to 
remove the file.

Objects

Specular Power Controls the sharpness of the object’s highlights and 
environment reflections. Lower values create blurry 
reflections (good for carpet), while higher values create 
sharper reflections (good for metal).

Objects

Normal Texture Uses a color image to simulate the lighting of small surface 
irregularities. RGB colors on the object surface correspond 
to XYZ values, indicating the direction that light reflects off 
the object. Click the button next to the texture field to 
select a texture image file. Click X to remove the file.

Vision uses tangent space normal maps.

Objects

Bump Texture Uses a grayscale image to simulate surface contours, such 
as brick work, for an embossed appearance. Bump 
textures can provide a greater sense of depth than normal 
textures, but performance may decrease. Click the button 
next to the texture field to select a texture image file. Click 
X to remove the file.

Objects

Alpha Texture Uses an image mask to simulate surface transparency or 
opacity. White areas appear opaque and black areas 
appear transparent. Click the button next to the texture 
field to select a texture image file. Click X to remove the 
file.

Objects

Force Emissive 
Mesh

Makes a texture image glow even when the ambient 
lighting is low. This is a good setting for video screens and 
LED tape.

Objects

Emissive Objects

Parameter Description Availability
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Fixture Type Converts geometry into a DMX-controlled emissive 
fixture, such as a glowing sphere. The brightness of RGB 
colors is controlled by separate channels.

Objects

Fixture Candela Sets the maximum output of the emissive fixture, 
controlling how brightly it glows

Objects

Fixture Universe Displays the universe assigned to the emissive fixture Objects
Fixture Channel Displays the DMX channel assigned to the emissive fixture Objects

Lighting Fixtures
Candela Sets the maximum output of the lamp in the fixture. 

Increase the value to make both the beam and the surface 
lights brighter.

Perceived brightness also depends on the beam and 
field angles of the fixture, the dimmer, and other 
components of the light train.

Fixtures

Color 
Temperature

Sets the temperature of emitted light. At 6000K, the light 
appears white. Larger values make the light appear cooler 
(blue), and smaller values make the light appear warmer 
(amber).

Fixtures

Force Emissive Converts the fixture to an emissive; the lens glows, but the 
fixture does not emit beams, create surface lights, or cast 
shadows. This is a good setting for blinders, LED fixtures, 
and performance-intensive multi-part fixtures. 

Emissive fixtures can significantly improve 
performance.

Fixtures

Beam Multiplier Multiplies the brightness of the beam without affecting 
surface lights.

This is not a real-world fix; adjust the beam by other 
parameters if possible.

Fixtures

Gobo Wheels Select a gobo image for the fixture to project. Click the 
button next to the slot number to select the image file for 
the slot. Click X to remove the file.

Fixtures

Color Wheels Select a color for each slot in the fixture’s color wheel. 
Click the button next to the color definition. The Color 
Picker dialog box opens. Color libraries from common 
manufacturers are listed in the Number column. Expand 
the list by clicking the disclosure arrows. Select a standard 
color from a manufacturer, or choose a color from the 
color picker. The Preview displays the selected color. The 
Hue, Saturation, and Luminance values, as well as the 
Red, Green, and Blue values, display.

Fixtures

MVR Objects, fixtures, and 
layers
(MVR only)

Parameter Description Availability
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~~~~~~~~~~~~~~~~~~~~~~~~~
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Preferences
DMX transforms
Focusing conventional fixtures

DMX transforms
Use DMX transforms to scale, rotate, and move selected items in the scene. Scaling and movement 
operations are independent from the object’s rotation. Scaling does not apply to fixtures.

To transform multiple selections at once, you can group them in a layer; see Organizing the scene contents. 
When a layer is transformed, all items contained in that layer are transformed accordingly. A transformed 
fixture’s pan and tilt are relative to the transformed position.

To significantly improve performance for DMX transforms, disable shadows from the Document 
preferences: Rendering tab. If shadows are needed, set the Texture Quality below Medium and set 
Dynamic Shadows to None from the Vision preferences: Graphics tab; shadows will be disabled only 
for transformed objects.

To scale objects by DMX input:

1. Select one or more objects. 

Alternatively, select a layer in the Scene Graph palette that contains all of the objects to transform. 
Fixtures cannot be scaled.

2. In the Properties palette, expand the XForm heading to access the parameters.

3. Set the XForm Universe to specify the universe.

4. Set the XForm Channel to specify the DMX address.

5. Enter the XForm Scale values to specify the scale factors. Scaling is not affected by the object’s 
rotation.

• Scale X sets the object’s X-axis scale.
• Scale Y sets the object’s Y-axis scale.
• Scale Z sets the object’s Z-axis scale.

6. Set the DMX profile for scaling.

UUID Displays the item’s unique ID for tracking by MVR; see 
Merging files

Objects, fixtures, and 
layers
(MVR only)

Invert Pan Inverts the fixture’s pan Fixtures
Invert Tilt Inverts the fixture’s tilt Fixtures

Channel Coarse/Fine Purpose %: Function
10 Coarse XForm Scale X 0–100
11 Fine

Parameter Description Availability
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To rotate items by DMX input:

1. Select one or more fixtures or objects.

Alternatively, select a layer in the Scene Graph palette that contains all of the items to transform.

2. In the Properties palette, expand the XForm heading to access the parameters.

3. Set the XForm Universe to specify the universe.

4. Set the XForm Channel to specify the DMX address.

5. Select the Rotation Axis, or select None.

6. Enter the Rotation Delta to set the maximum angle of index rotation.

7. Enter the Rotation Rpm to set the maximum speed of continuous rotation.

8. Set the DMX profile for the rotation.

There are three “dead zones” where no rotation occurs in the Continuous Rotation channel: 0%, 
49–51%, and 100%. The rotation is clockwise at 48–1% (where the effect increases as DMX value 
decreases) and counter-clockwise at 52–99%.

Rotation occurs around the local origin, not the world origin.

To move items by DMX input:

1. Select one or more fixtures or objects.

Alternatively, select a layer in the Scene Graph palette that contains all of the items to transform.

2. In the Properties palette, expand the XForm heading to access the parameters.

3. Set the XForm Universe to specify the universe.

12 Coarse XForm Scale Y 0–100
13 Fine
14 Coarse XForm Scale Z 0–100
15 Fine

Channel Coarse/Fine Purpose %: Function
7 Coarse XForm Rotation (Index) 0–100: Rotation
8 Fine
7 Coarse XForm Rotation (Continuous) • 0–0: No rotation

• 48–1: Clockwise rotation
• 49–51: No rotation
• 52–99: Counter-clockwise rotation
• 100–100: No rotation

8 Fine

9 XForm Rotation Control • 0–20: Index rotation
• 21–40: Continuous rotation
• 41–100: Reserved

Channel Coarse/Fine Purpose %: Function
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4. Set the XForm Channel to specify the DMX address.

5. Enter the XForm Delta values (in inches) to specify the direction and magnitude of movement. The 
movement is not affected by the item’s rotation. The direction is relative to the item’s local 
coordinate space.

• Delta X controls the range of lateral movement.
• Delta Y controls the range of upward/downward movement.
• Delta Z controls the range of forward/backward movement.

The Position X/Y/Z values in the Properties palette determine the selected items’ starting 
position. 

6. Set the DMX profile for the desired movement. 

50% indicates the center of the range of movement.
~~~~~~~~~~~~~~~~~~~~~~~~~
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Preferences
Modifying scene objects and fixtures

Assigning textures
Textures can display images or video from a file, or live streams from a video input.

In Vectorworks, the Vision video source can be specified with the Spotlight > Visualization > Select Vision 
Video Source command, or from the properties of a video screen. In the Vectorworks online help system, 
see “Identifying a Video Source for the Vision Program” for more information.

Assigning image or video files
To assign an image or video file to a texture:

1. Select one or more objects, and then click the button next to the Texture field on the Properties 
palette. 

2. Navigate to the image or video file and select it. 

The content displays on the selected objects. If a video file is selected, the video plays immediately 
and loops indefinitely.

To remove the texture file, click X next to the Texture field.

Channel Coarse/Fine Purpose %: Function
1 Coarse XForm Delta X 0–100: X axis movement
2 Fine
3 Coarse XForm Delta Y 0–100: Y axis movement
4 Fine
5 Coarse XForm Delta Z 0–100: Z axis movement
6 Fine
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Assigning video inputs
Textures can display different types of video input, including capture cards and Network Device Interface 
(NDI) protocol.

The number of NDI inputs that can display in the scene depends on your Vision license. If more inputs 
are assigned than your license allows, the associated textures are rendered as black.

The Scene window status bar indicates the status of certain input types, such as the status of all NDI inputs 
that are assigned to textures.

•  None: No video inputs of this type are assigned.

•  Good: All assigned video inputs are available.

•  Partial: Some of the assigned video inputs are unavailable.

•  Bad: No assigned video inputs are available.

For these types of video input, the status of individual inputs is indicated in the Select Video Input dialog 
box.

To assign a video input to a texture:

1. With one or more objects selected, do one of the following:

• Right-click in the viewport and select Assign Video Input from the context menu. From the 
Assign Video Input dialog box, specify a name for the texture. If the specified texture already has 
an assigned video input, the video displays on the selected objects. If a new name is entered, 
proceed to step 2.

• Click the button next to the Texture field on the Properties palette. Navigate to textures\App 
within the Vision folder, and select a capture file. Ten .cap files are provided, and more can be 
created as needed. If the .cap file already has an assigned video input, the video displays on the 
selected objects. If the .cap file is unused, proceed to step 2.

2. The Select Video Input dialog box opens. All scene objects with the selected texture display a 
checkerboard pattern for identification. Proceed to step 5 if not cropping the video input. 

Click to show/hide the parameters.

Parameter Description
Video input list Lists all available video inputs with a prefix indicating the type. The 

status is displayed for certain types, such as NDI.
•  Good: The video input is available.
•  Bad: The video input is unavailable.

The status icon updates automatically when the status changes.
Crop Selected Video Input Crops the video input for display. Different portions of the same 

input can display on different objects, creating a split-screen effect.
Delete Selected Crop Video 
Input

Removes the selected video input from the list

Preview Displays a preview of the selected video input and its resolution
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3. Select Crop Selected Video Input to define the area of the video input that displays.

The Crop Selected Video Input dialog box opens. 

4. Either enter the right, left, top, and bottom coordinates of the desired area, or use the handles on 
the preview to position the video. Click OK to return to the Select Video Input dialog box.

The video crop displays, and shows its coordinates, in the list of available inputs.

5. Select a video input, and click OK. 

The video displays on the selected objects.

To remove the assigned texture, click X next to the Texture field.
~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Preferences
Modifying video inputs
Resetting video inputs
Managing assigned video inputs

Modifying video inputs

Certain types of video input have options for their modification. 

To modify a video input:

1. Select an object with the texture input to modify, and select the command.

The Modify Video Input dialog box opens.

Click to show/hide the parameters.

2. Select the desired options.

All objects with the selected texture display the modified input. 
~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Assigning textures
Resetting video inputs

Options Options display for certain types of input. You can set the bandwidth 
for NDI inputs. For best performance, select Low Bandwidth.

Command Path
Modify Video Input Viewport context menu

Parameter Description
Preview Displays a preview of the video input and its resolution
Low/High Bandwidth
(NDI only)

Sets the video bandwidth. Select Low Bandwidth for best 
performance.

Parameter Description
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Managing assigned video inputs

Resetting video inputs
You can reset one or more video inputs, to change the inputs assigned to textures.

Resetting a single video input

To reset a video input: 

1. Select an object with the texture input to change, and select the command. All objects with the 
selected texture display a checkerboard pattern for identification.

The Select Video Input dialog box opens. 

2. Select a video input for the specified texture, as described in Assigning video inputs.

All objects with the selected texture display the new input.

Resetting multiple video inputs 

To reset one or more video inputs: 

1. Select the command.

An alert indicates the status of video inputs in the file. If all inputs are available, click OK. If 
some inputs are faulty, address the issues as described in Managing assigned video inputs.

The Select Video Input Texture dialog box opens, listing the textures in use.

2. Select a texture to change; Preview displays the assigned video input. All scene objects with the 
selected texture display a checkerboard pattern for identification.

3. Click Reset.

The Select Video Input dialog box opens. 

4. Select a video input for the specified texture, as described in Assigning video inputs.

All objects with the selected texture display the new input.

5. You are prompted to reset more video inputs. Click Yes to continue changing inputs, or click No to 
stop.

~~~~~~~~~~~~~~~~~~~~~~~~~
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Command Path
Reset Video Input Viewport context menu

Command Path
Reset Video Inputs Render
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Managing assigned video inputs
Video input assignments and crops are saved with the scene file. As described in Assigning video inputs, the 
Scene window status bar displays the current status of certain input types. If any assigned inputs are 
unavailable when the file is opened, a diagnostic alert indicates the faulty inputs. Vision will continue 
searching for these inputs while the alert is open. 

If assigned inputs are unavailable, do one of the following:

• Fix the connectivity issues: As faulty inputs are fixed, their status updates automatically in the 
diagnostic alert, which closes when all inputs are found. Click OK in the success alert.

• Assign a different video input: Click Cancel in the diagnostic alert. The Select Video Input dialog 
box opens to specify new inputs for the associated textures; see Assigning video inputs.

• Work without video inputs: Click Cancel in the diagnostic alert, and then click Cancel in the Select 
Video Input dialog box. The textures that are associated with unavailable inputs are rendered as 
black. If you choose to work without video inputs, the saved inputs can be restored mid-session. 

Capture cards must be plugged in when Vision is launched.

To restore assigned video inputs: 

1. Select Render > Restore Video Inputs. 

2. An alert displays the status of video inputs in the file.

• If faulty inputs remain, they are indicated for troubleshooting. Fix the connectivity issues.

• When all assigned inputs are available, click OK; the inputs automatically display on the 
associated textures.

~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Preferences
Assigning textures
Modifying video inputs
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Rendering video with Disguise EVO

Rendering video with Disguise EVO
Vision can integrate with Disguise EVO® for synchronized visualization of lighting and video. The integration 
uses DMX-controlled cameras and an exchange of NDI streams to sync the two programs. This allows 
Disguise to render video for Vision and control its camera movement.

To enable the integration with Disguise:

Activate and patch the Disguise camera as described in DMX control of the Disguise camera. Vision 
turns off the video rendering and outputs a live stream of the viewport for Disguise to receive. 

To disable the integration with Disguise: 

1. Deselect Disguise Camera in the DMX controls dialog box.

2. Click Yes when prompted to stop sending a live NDI stream of Vision and to turn on video 
rendering.
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Video rendering is turned on in Vision. Disguise no longer renders the video.
~~~~~~~~~~~~~~~~~~~~~~~~~
Using DMX controls
Setting document preferences

Modifying scene objects and fixtures
Selecting geometry

The Select tool selects an object or fixture in the Scene window. The selected item is also selected in the 
Scene Graph palette, and its parameters display in the Properties palette. 

If nothing is selected in the Scene window, the ROOT layer is selected in the Scene Graph palette, and 
the global scene parameters are displayed.

To select an object or fixture:

1. Click the tool.

2. Click an item in the Scene window. A bounding box displays around the selected item. If a fixture is 
selected, it outputs light.

Alternatively, select one or more items from the Scene Graph palette.

Multiple objects and fixtures can be selected by pressing the Ctrl (Windows) or Cmd (Mac) key while 
clicking on items in the Scene window.

Moving geometry
There are several ways to move objects and fixtures in the scene. The Move object tool is best for 
approximate movements. For exact movements, do one of the following:

• To move a single item—or multiple items of the same type—to a specific coordinate position, 
enter the Position X/Y/Z value in the Properties palette.

• To move items of any type by an exact distance, use the Move 3D command to move the items 
along the selected axis.

• To move items by DMX input, see DMX transforms.

Moving geometry by dragging

Tool Tool set Shortcut
Select Select X

Tool Tool set
Move object Modify Object
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To move objects and fixtures by dragging:

1. Click the tool.

2. Click one or more items in the Scene window and drag them to the desired location.

Moving geometry by command

Use the Move 3D command to move an object or fixture relative to its current position. You can also move 
multiple items by the same distance value. For example, select trusses with different trim heights and raise 
them all by 12 inches.

To move objects and fixtures by a specified distance:

1. Select the items to move.

2. Select the command.

The Move 3D dialog box opens.

Click to show/hide the parameters.

The selected items move accordingly. 

Rotating geometry
There are several ways to rotate objects and fixtures in the scene. The Rotate object tool is best for 
approximate rotations. For exact rotations, do one of the following:

• To rotate a single item—or multiple items of the same type—to a specific angle, enter the 
Rotation X/Y/Z value in the Properties palette.

• To rotate items of any type by a specified number of degrees, use the Rotate 3D command to 
rotate the items along the selected axis.

• To rotate items by DMX input, see DMX transforms.

Rotating geometry by dragging

Command Path Shortcut
Move 3D Edit • Ctrl+M (Windows)

• Cmd+M (Mac)

Parameter Description
X/Y/Z Axis Select the axis of movement
Distance Specify the distance to move (in inches)

Tool Tool set
Rotate object Modify Object
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To rotate objects and fixtures by dragging:

1. Click the tool.

2. Click one or more items in the Scene window and change their rotation angle by dragging with the 
mouse.

Rotating geometry by command

Use the Rotate 3D command to rotate an object or fixture relative to its current orientation. You can also 
rotate multiple items by the same degree value. For example, to flip a selection of fixtures, adjust the 
rotation by 180 degrees.

To rotate objects and fixtures by a specified number of degrees:

1. Select the items to rotate.

2. Select the command.

The Rotate 3D dialog box opens.

Click to show/hide the parameters.

The selected items are rotated accordingly. 

Resizing geometry

The Scale object tool changes the scale of an object or fixture in the Scene window.

To resize an object or fixture:

1. Click the tool.

2. Click on the item in the Scene window and change its scale up or down by dragging with the 
mouse.

Alternatively, change the scale of the selected item from the Properties palette.

Command Path
Rotate 3D Edit

Parameter Description
X/Y/Z Axis Select the axis of rotation
Rotation Angle Specify the angle of rotation

Tool Tool set
Scale object Modify Object
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Adding fixtures

New fixtures can be added to the scene with the Add Instrument tool.

You can use this method to add Vision fixtures, not GDTF fixtures.

To add an instrument to the scene:

1. Click the tool.

The Add Instrument Tool dialog box opens. 

2. Select the instrument to add.

Click to show/hide the parameters.

Adding objects

New objects can be added to the scene with the Add Object tool.

To add an object to the scene:

1. Click the tool.

The Add Object Tool dialog box opens. 

2. Select the object to add.

Tool Tool set
Add Instrument Modify Scene

Parameter Description
Instrument list Select an instrument for insertion. The available instruments can be listed in 

different ways; click the disclosure arrow to expand the list.
• All: Lists all instruments alphabetically by instrument name.
• Manufacturer: Lists all instruments alphabetically by manufacturer name.
• Type: Lists all instruments alphabetically by type.

Search Enter a search term, and click Search. Only instruments that contain the 
search term display in the instrument list; click the disclosure arrow to 
expand the list.

Universe Enter the DMX universe number assigned to the instrument
Channel Enter the DMX channel number assigned to the instrument
Trim Height Specify the height of the instrument above the zero plane

Tool Tool set
Add Object Modify Scene
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Click to show/hide the parameters.

The Modify Scene tool set contains additional tools to insert simple primitive objects into the scene, such as 
spheres or lines. 

To insert a simple object into the scene:

1. Click the Draw Sphere, Draw Box, Draw Cylinder, Draw Line, or Draw Point tool. 

2. Click in the Scene window. Drag the mouse to draw the object, and release the mouse when the 
object is at the desired scale. Lines are drawn by clicking, dragging, and clicking again to finish the 
line.

~~~~~~~~~~~~~~~~~~~~~~~~~
Vision basics
Editing the scene

Deleting scene objects and fixtures

There are multiple ways to delete objects and fixtures from the scene.

To delete items from the scene:

1. Do one of the following:

• From the Scene Graph palette, select the object or fixture to delete. Multiple items can be 
selected by selecting a layer, or by pressing the Shift key or the Ctrl (Windows) or Cmd (Mac) key 
while clicking on the items.

• From the Scene window, select the object or fixture to delete. Multiple items can be selected by 
pressing the Ctrl (Windows) or Cmd (Mac) key while clicking on the items.

Selected items are highlighted in the scene.

2. Select the appropriate command. The options depend on the items selected.

• To delete only the selected fixtures, select Delete Selected Fixtures.
• To delete all selected items, select Delete Selected.

If several items are selected, and only the fixtures should be deleted, select Delete Selected 
Fixtures. 

Parameter Description
Object list Select an object for insertion. The available objects are listed alphabetically 

by category; click the disclosure arrow to expand the list.
Filter Enter a search term, and click Search. The Search Results list displays objects 

that contain the search term.
Trim Height Specify the height of the object above the zero plane
Rotation Specify the rotation angle of the object

Command Path
• Delete Selected Fixtures
• Delete Selected

Context menu



52 | Editing the scene
The items are deleted from the scene.
~~~~~~~~~~~~~~~~~~~~~~~~~
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Replacing fixtures

Replacing fixtures

There are multiple ways to replace fixtures in the scene.

You cannot replace a Vision fixture with a GDTF fixture, or replace a GDTF fixture with a Vision fixture. 
To edit GDTF fixtures, see Updating GDTF fixtures.

To replace a fixture:

1. Do one of the following:

• From the Scene Graph palette, select the fixture to replace. Multiple fixtures can be selected by 
selecting a layer, or by pressing the Shift key or Ctrl key (Windows) or the Cmd key (Mac) while 
clicking on the fixtures.

• From the Scene window, select the fixture to replace. Multiple fixtures can be selected by 
pressing the Ctrl key (Windows) or Cmd key (Mac) while clicking on the fixtures.

Selected fixtures are highlighted in the scene.

2. Select the command. 

The Replace Instruments dialog box opens.

3. Select the replacement fixture.

Click to show/hide the parameters.

The original fixtures are replaced in the Scene Graph palette and the scene. The replacement fixtures have 
the same name, universe, channel, position, and rotation as the original fixtures. If the original and 
replacement are both conventional fixtures, the manual pan and tilt are maintained.
~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene

Command Path
Replace Selected Fixtures Context menu

Parameter Description
Instrument list Select an instrument to use as the replacement. The available instruments 

can be listed in different ways; click the disclosure arrow to expand the list.
• All: Lists all instruments alphabetically by instrument name.
• Manufacturer: Lists all instruments alphabetically by manufacturer name.
• Type: Lists all instruments alphabetically by type.

Search Enter a search term, and click Search. Only instruments that contain the 
search term display in the instrument list; click a disclosure arrow to expand 
the list.
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Modifying scene objects and fixtures
Focusing conventional fixtures

Updating GDTF fixtures

You can modify GDTF fixtures in the scene by opening the GDTF Fixture Builder directly from Vision. 
Internet access is required. When saving a fixture in the Fixture Builder, the associated .gdtf file is updated, 
along with each instance of that fixture type in the scene. This is a local update to the scene file; it does not 
affect the fixture on the GDTF Share. The .gdtf file is saved with the .v3s file. 

To update a GDTF fixture:

1. Select the fixture in the Scene window, and select the command. The associated .gdtf file opens in 
the Fixture Builder while Vision stays open in the background.

If the GDTF fixture is not properly configured, a list of errors displays. See the GDTF Help for more 
information about creating a valid fixture. 

2. Edit the fixture in the Fixture Builder. Only the DMX Mode name cannot be changed.

3. When the edits are complete, click Save to save the updated fixture. 

4. An alert opens, confirming that you want to update all fixtures of this type in the scene. Click OK to 
update the .gdtf file and all associated fixtures, and to close the Fixture Builder.

~~~~~~~~~~~~~~~~~~~~~~~~~
Data exchange for previsualization
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Editing the scene
Modifying scene objects and fixtures
Focusing conventional fixtures

Focusing conventional fixtures

A conventional fixture is a non-moving fixture. If the conventional fixtures are focused in Vectorworks prior 
to import, they are automatically focused in Vision. Otherwise, these lights need to be manually adjusted so 
they point to the desired location. 

By default, all unfocused conventional fixtures point down in the hung position and point up in the 
floor-mounted position.

To focus one or more conventional fixtures:

1. Select the fixture(s) to focus. The selected fixtures automatically output light in the Scene window. 

2. Right-click on the desired location in the scene, and select the command.

Alternatively, use the arrow keys to pan and tilt the selected fixtures to achieve the desired focus.

Command Path
Update Fixture Type Context menu

Command Path
Focus Selected Lights Here Context menu

https://fixturebuilder.gdtf-share.com
https://gdtf-share.com/
https://gdtf-share.com/help/en/help/gdtf_builder/index.html
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The selected fixtures are focused to the location.

When several conventional fixtures are selected, each fixture in the selection can be focused 
independently. Cycle through the selected fixtures to focus them one at a time.

To focus selected conventional fixtures one at a time:

1. Select the fixtures to focus. The selected fixtures automatically output light in the Scene window.

2. Use the Page Up/Page Down keys to traverse the selected fixtures, based on their order in the 
Scene Graph palette. 

Press the Page Down key to focus the first selected fixture and to cycle down the list. Press the 
Page Up key to focus the last selected fixture and to cycle up the list.

The fixture to focus displays its normal light beams, while the other fixtures emit blue light.

3. Use the arrow keys to pan and tilt the highlighted fixture to achieve the desired focus.

4. Continue pressing the Page Up or the Page Down key to traverse the selected fixtures. Use the 
arrow keys to focus each fixture as needed.

When the cycle is complete, all selected fixtures display their normal light beams.

~~~~~~~~~~~~~~~~~~~~~~~~~
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Preferences
The Software Console palette

The Software Console palette
Command Path Shortcut
Software Console Window • Ctrl+Shift+S (Windows)

• Cmd+Shift+S (Mac)

Cycle through the selected conventional fixtures to focus them 
one at a time; the fixture to focus is highlighted
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Additional properties of conventional (non-moving) fixtures, such as gobo, iris, focus, and shutters, can be 
adjusted from the Software Console palette. If the conventional fixtures are imported from Vectorworks, 
some parameters, such as shutters and barn doors, are already set.

To open the Software Console palette:

Select the command.

To adjust the properties of a conventional fixture from the Software Console palette:

1. Select a conventional fixture from the Scene Graph palette. 

When selected, the fixture automatically outputs light in the Scene window. 

2. In the Software Console palette, adjust the sliders, or enter a value, to change the parameter 
settings. The available parameters depend on the type of conventional fixture selected.

The Scene window displays the result of the adjustment in real time.

~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Preferences

Saving the scene as an image

Vision allows you to create still images of the Scene window displaying the current lighting status. When the 
Scene window displays four viewports, the bottom right viewport is used to create the image. Still images 

Command Path
Render Still Render

Adjusting the value 
changes the display in 
the Scene window in 
real time
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are saved in .jpg format. Specify the image render settings, and optionally save them as a preset. For more 
information on saving and managing the Render Still presets, see Using saved sets.

To save the Scene window as a still image:

1. Properly configure the scene and create the desired lighting look.

2. Select the command.

The Render Still dialog box opens.

Click to show/hide the parameters.

3. Select a set of image render settings from the Settings Preset list, or select <Active Settings> to use 
the settings currently specified in the Vision Preferences dialog box.

4. Click Customize to specify the image render settings. 

The Vision Preferences dialog box opens, but only the Graphics tab is available. The top portion of 
the dialog box offers options for saving and managing presets. The Graphics tab displays the 
rendering parameters. Set the parameters as desired.

Click to show/hide the parameters.

5. Do one of the following:

• To save the currently specified settings as a preset, see Using saved sets. 
• To use the currently specified settings without saving them as a preset, click OK.

6. From the Render Still dialog box, select the image Resolution. If the image will be printed, set the 
dpi. 

Parameter Description
Settings Preset Select a set of image render settings, or select <Active Settings> 
Customize Opens the Vision Preferences dialog box to specify and save the image 

render settings
Resolution Select the image resolution in pixels, or select Custom Print Size
Print Size For printing purposes, displays the custom width and height in inches 

and the dpi
Output Filename Displays the image file name and location

Parameter Description
Graphics Many of the same parameters display when setting the Vision 

application preferences; see Vision preferences: Graphics tab for 
parameter descriptions

Render Buffer Size To help achieve the desired resolution, select a size that is smaller 
than the Resolution in the Render Still dialog box. 

Smaller sizes increase the render time, but also make it possible 
to render high-resolution images.
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For finer control of the print size, set the Resolution to Custom Print Size and specify the Print Size 
dimensions.

7. Click the button next to the Output Filename field, and set a name and location for the image file.

8. Click Render to save the image.
~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Saving the scene as a movie

Saving the scene as a movie

Vision allows you to render the current scene and save it as a video file in .mpg format. To create a video, 
the scene must have an associated DMX file. Specify the movie render settings, and optionally save them as 
a preset. For more information on saving and managing the Render Movie presets, see Using saved sets.

If video screens or geometry are displaying video from a file or capture source within the scene, the 
video playback is not synchronized to the exported video.

To save the Scene window as a video file:

1. Open the scene file to use for the video.

2. Select the command.

The Render Movie dialog box opens.

Click to show/hide the parameters.

3. Select a set of movie render settings from the Settings Preset list, or select <Active Settings> to use 
the settings currently specified in the Vision Preferences dialog box.

4. Click Customize to specify the movie render settings.

Command Path
Render Movie Render

Parameter Description
Settings Preset Select a set of movie render settings, or select <Active Settings> 
Customize Opens the Vision Preferences dialog box to specify the movie 

render settings
Resolution Select the video resolution in pixels
Frame Rate Specify the frame rate in frames per second (fps)
DMX Recording Displays the DMX recording to use for the video
DMX Start Time Specify when to start the video in the DMX recording
DMX End Time Specify when to end the video in the DMX recording
Output Filename Displays the video file name and location
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The Vision Preferences dialog box opens, but only the Graphics tab is available. The top portion of 
the dialog box offers options for saving and managing presets. The Graphics tab displays the 
rendering parameters. Set the parameters as desired.

Click to show/hide the parameters.

5. Do one of the following:

• To save the current settings as a preset, see Using saved sets. 
• To use the current settings without saving them as a preset, click OK. 

6. From the Render Movie dialog box, select the video Resolution. 

7. Set the video Frame Rate.

8. Click the button next to the DMX Recording field, and select the DMX file to use for the video. 

9. Set the DMX Start Time and the DMX End Time.

10. Click the button next to the Output Filename field, and set a name and location for the video file.

11. Click Render to save the video.

The progress bar displays while the video renders. The actual rendering does not display on the 
screen.

To cancel the rendering and save the video file as-is, click Cancel. The file is saved in the specified 
location.

~~~~~~~~~~~~~~~~~~~~~~~~~
Editing the scene
Recording and playing DMX files
Saving the scene as an image

Patching

Use the Patch dialog box to view and edit the DMX address of the following scene items: 

• Fixtures
• RGB mesh objects

Parameter Description
Graphics Many of the same parameters display when setting the Vision 

application preferences; see Vision preferences: Graphics tab for 
parameter descriptions

Render Buffer Size To help achieve the desired resolution, select a size that is smaller 
than the Resolution in the Render Movie dialog box. 

Smaller sizes increase the render time, but also make it 
possible to render high-resolution videos.

Command Path Shortcut
Patch Window • Ctrl+Shift+P (Windows)

• Cmd+Shift+P (Mac)
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• Layers with DMX transforms
• DMX-controlled cameras
• DMX-controlled ambient intensities
• DMX-controlled haze vertical/horizontal speeds

The address of a single item can be edited directly from the Patch list. To edit the patching of multiple 
items, use context menu commands to set the universe, to patch items sequentially, and to resolve conflicts 
(see Assigning patch information). In addition to DMX patching, you can sort and filter the Patch list to view 
the desired data, and export, import, and print patching data.

To open the Patch dialog box:

Select the command.

Click to show/hide the parameters.

Parameter Description
Filter Filters the scene items by a specified universe, fixture manufacturer, item 

type, or displayed name. Select Show All to display all of the patchable 
scene items in the Patch list.
The Filter field is also a search box. Type some or all of the text for the 
desired filter and press Enter; the search is case-insensitive. 

Export Exports the patch information for all scene items in comma-separated 
value (csv) format to a Vision .v3p patch file; specify the file name and 
location

Filter
Channel Availability 

diagram

Red: 
Channels 
in conflict

Green: 
Channels 
in use

Gray: 
Available 
channels

Items with 
patching 
conflicts

Patch list
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~~~~~~~~~~~~~~~~~~~~~~~~~
Assigning patch information
Viewing received DMX
Using DMX controls

Assigning patch information
Properly configured addresses are required for scene items to respond to a DMX lighting console. In the 
Vision program, all universes and channels start at 1, not 0 (zero). 

Fixtures, RGB mesh objects, and DMX transforms can be patched from the Properties palette or the Patch 
dialog box. DMX-controlled items can be patched from the DMX Controls dialog box or the Patch dialog 
box.

The Patch dialog box displays all patchable scene items and their address information, sorted and filtered as 
desired. The channel availability diagram shows channel usage and errors for each universe. 

The number of universes depends on the Vision dongle and license.

Setting the address
To quickly change the address of a single item:

1. From the Patch list, double-click on the Universe or Channel number. 

2. Edit the value directly.

To set the universe for a selection of items:

1. Select one or more items from the Patch list.

2. Right-click on a selected item and select the command.

The Set Universe dialog box opens.

3. Specify a universe for the item or items.

Import Imports patch information from a Vision .v3p patch file
Print Saves the patch information as a PDF file
Finished Closes the Patch dialog box
Patch list Lists the scene items and their patch information (according to the 

selected Filter), including universe and channel assignment; click on a 
column heading to sort the list in ascending or descending order

Channel Availability Displays channel usage per universe. Green areas represent channels in 
use, and red are in conflict. 
The number of universes shown depends on the Vision dongle and 
license.

Command Path
Set Universe Context menu

Parameter Description
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Patching sequentially

A selection of items can be assigned to sequential channels in a specified universe.

To patch items sequentially:

1. Select the items from the Patch list.

2. Right-click on a selected item and select the command.

The Patch Sequentially dialog box opens.

3. Specify a universe for the items, and then set the first channel. 

The selected items are patched sequentially based on the specified start address.

Resolving conflicts

When there is a conflict due to overlapping or duplicated addresses, they display with a red highlight in the 
Patch list and the Channel Availability diagram. Conflicts can be resolved automatically.

To resolve conflicts:

1. Select the items with a conflict from the Patch list.

2. Right-click on a selected item and select the command.

If space is available in the universe, an appropriate DMX address is assigned to the items, resolving 
the conflicts.

~~~~~~~~~~~~~~~~~~~~~~~~~
Patching
Viewing received DMX
Using DMX controls

Viewing received DMX

When a lighting console is connected, you can view the incoming DMX information from the console.

To view the DMX information:

1. Select the command.

The DMX Provider dialog box opens. 

2. Specify the protocol to connect to the lighting console, and click OK.

Command Path
Patch Sequentially Context menu

Command Path
Resolve Conflicts Context menu

Command Path
DMX Viewer DMX
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The DMX Viewer opens. This is a separate dialog box that opens along with Vision, and it can 
remain open while Vision is in use.

3. For each selected Universe, the current DMX information sent from the console displays. The 
Display Type can be toggled between Decimal and Percentage.

4. Click X to close the DMX Viewer.
~~~~~~~~~~~~~~~~~~~~~~~~~
Patching
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Using DMX controls

Using DMX controls
Vision uses DMX to allow a lighting console, or a program such as Disguise EVO, to control specific features 
of the application. These features include:

• Cameras that control the viewport view
• Ambient lighting intensity
• Haze speed in vertical and horizontal directions

When these features are properly patched, the lighting console or the Disguise program can sync with 
Vision and control the features with DMX.

Three camera types can be externally controlled. The cameras have different behavior, as described in the 
following sections: 

• Relative camera: DMX control of the Relative camera
• Absolute camera: DMX control of the Absolute camera
• Disguise camera: DMX control of the Disguise camera

The DMX information follows the Last Takes Precedence (LTP) priority; the latest information sent takes 
priority. The patching is saved in the .v3s file.
~~~~~~~~~~~~~~~~~~~~~~~~~
Patching
Viewing received DMX
DMX control of the Relative camera
DMX control of the Absolute camera
DMX control of the Disguise camera
DMX control of ambient lighting
DMX control of haze speed

DMX control of the Relative camera

The Relative camera is an orbiting camera that allows unlimited movement within the Vision scene. It uses 
DMX to control the direction and speed of camera movement. The camera relies on saved views to provide 
a starting view point. Up to nine saved camera views are available, corresponding to the nine Relative 
camera items in the DMX Controls dialog box. These virtual views are set up and stored within the .v3s file.

Command Path Shortcut
DMX Controls DMX • Ctrl+Shift+C (Windows)

• Cmd+Shift+C (Mac)
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To enable external control of the Vision view with a Relative camera:

1. Select the command.

The DMX Controls dialog box opens.

2. To activate and control the camera views, select the check box for the Camera (Relative) to use and 
specify the Universe and Channel number. There are 11 channels per DMX camera.

• 1% = decreasing quickly
• 50% = no change
• 99% = increasing quickly

When Vision is synced with a lighting console, or other integrated program, activating a Relative 
camera changes the viewport to the selected camera view.

~~~~~~~~~~~~~~~~~~~~~~~~~
Using DMX controls
Patching
Assigning patch information

Channel Coarse/Fine Purpose %: Function
1 Activation • 0–49: Deactivate camera

• 50–100: Activate camera
2 Coarse Pan Horiz • 0–0: No pan

• 1–48: Pan left
• 49–51: No pan
• 52–99: Pan right
• 100–100: No pan

3 Fine

4 Coarse Pan Vert • 0–0: No pan
• 1–48: Pan down
• 49–51: No pan
• 52–99: Pan up
• 100–100: No pan

5 Fine

6 Coarse Orbit Horiz • 0–0: No orbit
• 1–48: Orbit left
• 49–51: No orbit
• 52–99: Orbit right
• 100–100: No orbit

7 Fine

8 Coarse Orbit Vert • 0–0: No orbit
• 1–48: Orbit up
• 49–51: No orbit
• 52–99: Orbit down
• 100–100: No orbit

9 Fine

10 Coarse Zoom • 0–0: No zoom
• 1–48: Zoom in
• 49–51: No zoom
• 52–99: Zoom out
• 100–100: No zoom

11 Fine
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Viewing received DMX

DMX control of the Absolute camera

The Absolute camera uses DMX to set the camera position. This camera navigates the Vision scene within a 
fixed range of movement: -1000 m to 1000 m on any given axis. Unlike the Relative camera, the Absolute 
camera moves by pan and tilt (or yaw and pitch motion) instead of orbiting. You can control the field of 
view, and saved views are not required.

Because the Disguise camera uses the same functionality as the Absolute camera, they cannot be 
active at the same time.

To enable external control of the Vision view with an Absolute camera:

1. Select the command.

The DMX Controls dialog box opens.

2. To activate the camera view, select the check box for Camera (Absolute) and specify the Universe 
and Channel number. 

Command Path Shortcut
DMX Controls DMX • Ctrl+Shift+C (Windows)

• Cmd+Shift+C (Mac)

Channel Coarse/Fine/Ultra Purpose %: Function
1 Coarse Position X 0–100: -1000m–1000m
2 Fine
3 Ultra
4 Coarse Position Z 0–100: -1000m–1000m
5 Fine
6 Ultra
7 Coarse Position Y 0–100: -1000m–1000m
8 Fine
9 Ultra
10 Coarse Pan 0–100: -720°–720°
11 Fine
12 Ultra
13 Coarse Tilt 0–100: -720°–720°
14 Fine
15 Ultra
16 Coarse Vertical Field of View 

(FOV)
0–100: 22.5°–225°

17 Fine
18 Ultra
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When Vision is synced with a lighting console, or other integrated program, the view changes to 
match the Absolute camera position.

~~~~~~~~~~~~~~~~~~~~~~~~~
Using DMX controls
Patching
Assigning patch information
Viewing received DMX

DMX control of the Disguise camera

Vision uses a DMX-controlled camera to sync with Disguise EVO for media programming. See Rendering 
video with Disguise EVO for more information on enabling and disabling the Disguise integration. The 
Disguise camera is a type of Absolute camera, whose behavior is described in DMX control of the Absolute 
camera.

The Disguise camera and the Absolute camera cannot be active at the same time.

To enable Disguise to control the Vision view:

1. Select the command.

The DMX Controls dialog box opens.

2. To activate the Disguise camera, select the check box for Disguise Camera and specify the Universe 
and Channel number. 

Command Path Shortcut
DMX Controls DMX • Ctrl+Shift+C (Windows)

• Cmd+Shift+C (Mac)

Channel Coarse/Fine/Ultra Purpose %: Function
1 Coarse Position X 0–100: -1000m–1000m
2 Fine
3 Ultra
4 Coarse Position Z 0–100: -1000m–1000m
5 Fine
6 Ultra
7 Coarse Position Y 0–100: -1000m–1000m
8 Fine
9 Ultra
10 Coarse Pan 0–100: -720°–720°
11 Fine
12 Ultra
13 Coarse Tilt 0–100: -720°–720°
14 Fine
15 Ultra
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3. If the rendering preferences have not already been set for Disguise integration, two alerts open. 
When prompted, click Yes to send a live NDI stream of Vision and to render video screens with 
Disguise. 

~~~~~~~~~~~~~~~~~~~~~~~~~
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DMX control of ambient lighting

To use DMX for the ambient intensity: 

1. Select the command.

The DMX Controls dialog box opens.

2. To control the ambient intensity, select the check box for Ambient Intensity and specify the 
Universe and Channel number.

~~~~~~~~~~~~~~~~~~~~~~~~~
Using DMX controls
Patching
Assigning patch information
Viewing received DMX

DMX control of haze speed

To use DMX for the haze speed: 

1. Select the command.

16 Coarse Vertical Field of View 
(FOV)

0–100: 22.5°–225°
17 Fine
18 Ultra

Command Path Shortcut
DMX Controls DMX • Ctrl+Shift+C (Windows)

• Cmd+Shift+C (Mac)

Channel Coarse/Fine Purpose %: Function
1 Ambient • 0–0: No ambient

• 1–100: Ambient value

Command Path Shortcut
DMX Controls DMX • Ctrl+Shift+C (Windows)

• Cmd+Shift+C (Mac)

Channel Coarse/Fine/Ultra Purpose %: Function
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The DMX Controls dialog box opens.

2. To control the speed of the haze texture image as it moves in vertical and horizontal directions, 
select the check box for Haze Vertical/Horizontal Speed and specify the Universe and Channel 
number. 

~~~~~~~~~~~~~~~~~~~~~~~~~
Using DMX controls
Patching
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Viewing received DMX
Recording and playing DMX files

Recording and playing DMX files
The DMX recorder

Vision allows real-time recording of the incoming DMX stream. This recorded DMX stream can be used to 
play back lighting looks and sequences when no controller is connected.

To open the DMX Recorder:

Select the command.

The DMX Recorder is a separate application that opens along with Vision. 

Channel Coarse/Fine Purpose %: Function
1 Coarse Haze Vertical Speed • 0–0: No direction

• 1–48: Haze left
• 49–51: No direction
• 52–99: Haze right
• 100–100: No direction

2 Fine

Channel Coarse/Fine Purpose %: Function
1 Coarse Haze Horizontal Speed • 0–0: No direction

• 1–48: Haze left
• 49–51: No direction
• 52–99: Haze right
• 100–100: No direction

2 Fine

Command Path Shortcut
DMX Recorder Window • Ctrl+Shift+D (Windows)

• Cmd+Shift+D (Mac)
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Click to show/hide the parameters.

Recording a DMX file
Before recording, ensure that the lighting console is properly connected and that the correct 
communication protocol has been specified.

1. Click Record on the DMX Recorder.

2. Send the DMX stream to Vision. All DMX values are recorded as they are received; any subsequent 
cues or effects played on the lighting console will be recorded.

3. Click Record again to stop the recording.

The Save DMX dialog box opens. Specify a name and location for the .dmx file. The saved DMX file 
is currently loaded by default and is ready to play, or it can be loaded and played by selecting it with 
Load DMX. 

Parameter Description
Timeline slider Scrubs the timeline to the desired location; click Play to begin viewing the 

DMX file at that location
Return to 00:00:00 Returns the timeline slider to the start point of the DMX file and stops the play
Play/Pause Toggles between playing and pausing the DMX file
Record/Stop Press once to start recording the DMX file, and press again to stop recording 

and save the file
Loop When the DMX file ends, loops the playback to the beginning to continuously 

play the file; press again to stop looping
Load DMX Opens a DMX file for playback; the DMX file needs to correspond with the 

fixtures in the current Vision file for correct playback to occur
Convert DMX Opens a DMX file for conversion from a previous version of Vision

To record from a DMX stream:

Timeline slider

Return to 00:00:00

Play/Pause

Record/Stop

Loop

Current position 
in the timeline
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Opening a DMX file
To open (load) a DMX file:

1. Click Load DMX on the DMX Recorder.

The Open DMX dialog box opens.

2. Select the .dmx file to open.

Playing a DMX file
Before playing the currently loaded DMX file, open the corresponding Vision file.

1. Click Play on the DMX Recorder.

2. The DMX file plays within the Vision application window, replacing the current view in the Scene 
window. 

To pause the playback, click Play again. The Scene window returns to its former display. Click Play 
to resume the playback.

3. At the end of the timeline, playback stops and the Scene window returns to its former display, 
unless Loop mode is enabled. Looping playback continues until Loop is disabled or the playback is 
paused.

Pausing a DMX file

1. Click Play on the DMX Recorder.

The Scene window pauses; the DMX signal input continues, but DMX playback from the file is 
paused.

2. Click Play again. DMX playback from the file resumes in the Scene window.

Looping DMX file playback

1. Click Loop on the DMX Recorder.

2. Click Play.

The DMX file begins playback. At the end of the timeline, playback loops back to the beginning and 
plays continuously until Loop is disabled.

To play the current DMX file:

To pause the DMX file:

To loop DMX file playback:
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Using the help system
For information about this help system, please navigate to help.vectorworks.net and refer to the section on 
using the help.

Context-sensitive help
Context-sensitive help is available within the Vision program. To learn more about a feature, do one of the 
following:

• For a dialog box, click the ? icon on the Title bar.

• For a selected tool or dialog box, press F1.

On a Mac (aluminum keyboard), press Fn+F1.

• For a tool, a palette, the Scene window, or the NDI status indicator, select Help > What’s This? 
Then move the question mark cursor to the feature of interest, and click it.

To deactivate the “What’s This?” question mark cursor, select Help > What’s This? again.

The relevant help topic is opened. You can simultaneously view the help and the Vision application. 

Vision cannot directly access context-sensitive help for some commands. To view help for these items, 
launch the help system and locate the topic by conducting a search.

Copyright and trademark information
Copyright 2016-2020. All rights reserved.

Vision is a product of Vectorworks, Inc.

The Vision documentation is produced by the Technical Publications department of Vectorworks, Inc.

Contributions were provided by Kevin Linzey, Dedrick Duckett, Brandon Budzon, Brandon Eckstorm, Joshua 
Glassman, Mark Eli, Edward Joseph, Moritz Staffel, and Marissa Farrell. The Vision/Vectorworks diagram is 
based on a contribution from Caleb Taylor.

This documentation, as well as the software described in it, is furnished under license and may only be used 
or copied in accordance with the terms of such license. The information in this guide is furnished for 
informational use only, is subject to change without notice, and should not be construed as a commitment 

Click here for a video tip about this topic (internet access required).

http://help.vectorworks.net
https://www.youtube.com/watch?v=nG9YnJVNE54
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by Vectorworks. Vectorworks assumes no responsibility or liability for any errors or inaccuracies that may 
appear in this documentation.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval 
system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, 
without the express prior written permission of Vectorworks. Permission is typically granted to reproduce 
materials for personal use, but under no circumstances may it be used for commercial purposes or for 
financial gain. To obtain permission, contact Vectorworks (email tech@vectorworks.net) or an authorized 
Vectorworks distributor if not in the USA.

Existing artwork or images that you may desire to scan or copy may be protected under copyright law. The 
unauthorized incorporation of such artwork into your work may be a violation of the rights of the author or 
illustrator. Please be sure to obtain any permission required from such authors.

Vectorworks is a registered trademark of Vectorworks, Inc. Braceworks is a trademark of Vectorworks, Inc.

The following are copyrights or trademarks of their respective companies or organizations:

This software uses libraries from assimp, Open Asset Importer Library. Assimp is released as Open Source 
under the terms of a 3-clause BSD license. Copyright © 2006-2015 assimp team. All rights reserved.

This software integrates with disguise EVO®, Disguise Systems Limited.

This software uses code from FFmpeg licensed under the LGPLv2.1, and its source can be downloaded here. 
FFmpeg is a trademark of Fabrice Bellard, originator of the FFmpeg project.

NDI® is a registered trademark of NewTek™ Incorporated.

Xerces-C++ is made available under the Apache® Software License, Version 2.0 (the “License”); you may not 
use this file except in compliance with the License. You may obtain a copy of the License at http://
www.apache.org/licenses/LICENSE-2.0. Unless required by applicable law or agreed to in writing, software 
distributed under the License is distributed on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied. See the License for the specific language governing permissions 
and limitations under the License.

mailto:tech@vectorworks.net
http://www.assimp.org
http://ffmpeg.org
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html
https://www.vectorworks.net/support/custom
https://bellard.org/
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